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Welcome to ReCycle 2.0!

First of all we'd like to thank you for purchasing ReCycle 2.0! You are now in
possession of a unique tool which will be an enormous time saver and which will
add great creative possibilities to your music making.

Before ReCycle, using drum loops was very technical. Also, once you had com-
mitted yourself to a sample, you were stuck with its inherent tempo, its bass
drum pattern, its snare sound etc. A bit like painting by numbers.

With ReCycle all that has changed. This program puts you — the musician —
back in control, and lets you concentrate on what you do best. Which of course
is creating music.

What can | do with
ReCycle?

With ReCycle, you can perform a number of pretty amazing “tricks” on your

drum loops:

* Change the tempo without affecting pitch.

» Change the pitch without affecting tempo.

* Quantize drum loops (either to straighten up the timing or to change the feel,
for example by applying a “groove map”).

+  Extract the timing (a groove map) from a drum loop. This can then be applied
to other sequenced parts or even to other loops!

* Replace individual sounds in a drum loop.

« Edit the actual playing in the drum loop without affecting the basic feel.

* Extract sounds from loops.

¢ Process the loops with various effects.

Copyright Issues

The raw material with which you feed ReCycle is drum loops, grooves, break-
beats, or whatever sampled weirdness you find appropriate. Included in this
package is a great selection to get started with. When you grow out of that you'll
find a wealth of other sampling CDs and CD-ROMs out on the market to pick
from. However, please read the following text carefully:

Every published recording carries a warning, like this:

+ "All rights of the producer and owner of the recorded work are protected by
law, unauthorized copying, public performance..."

The text above means it is illegal to use this recording in your own work, unless
you obtain permission (see below).

! Failing to observe a copyright warning may result in legal action
taken against you. Make absolutely sure any material you use in
your own recordings is cleared for use, or you may find yourself in
serious legal trouble!

Some CDs (and other media) are created specifically for sampling. Even then
you must ensure the result is properly cleared for use in your own recordings. If
you find a disclaimer text that goes something like the one below, beware:

» "Every effort has been made to ensure that this CD contains sounds you can
safely use in your music. However, the producers of this product can not ac-
cept responsibility for any direct or consequential loss..."

In this case, please contact the producer to find out exactly what applies. Again,
do not use any material from this medium without making sure it is properly
cleared for use.

Clearing

So, how do you go about obtaining permission to use a recording, often referred
to as “clearing a sample”?

The owner of a CD is listed on the CD, in conjunction with a “P” symbol and a
date. Contact the owner to obtain permission. If you can't find the owner, con-
tact the company following the © symbol on the CD. If you can't find that either,
contact the manufacturer or record label listed on the packaging. Please note
that there are several types of clearance, for different types of usage. Preferably
contact an attorney familiar with copyright law, for assistance.
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About This Manual

MacOS vs. Windows

The documentation is both for the MacOS and Windows versions of ReCycle
2.0. Most pictures show the Macintosh version but things are identically titled
and positioned in both versions.

Sometimes, a key command is different in the two versions. This is indicated like
this: Hold down [Option] (Mac) / [Alt] (Win) and...

Everything said in the manuals applies to both platforms, unless explicitly stated
otherwise.
On-Line Help (Windows only)

* ReCycle for Windows has on-line help with a Menu Reference, window help
and help for specific dialogs from within the program.
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Requirements

To use ReCycle for Macintosh you need the following:

* Any Power Macintosh with a CD-ROM drive and 16-bit audio.

* 16 MB of RAM or more.

* System 8.6 or later.

For communication with your specific sampler, you might also need:
* A MIDI interface and cables, and/or...

* A SCSlinterface and SCSI cables.

For SCSI communication, your computer must use SCSI Manager 4.3 (see
page 13).

Setting Up The Computer

Before proceeding, your computer should be set up and you should be reason-

ably familiar with its operation. You should also install all peripherals, such as a
MIDI interface etc.

Turning on your system

1. If you have any peripherals connected to the computer or sampler,
always turn these on first.

2. If you are using a sampler with the operating system on a floppy
disk or hard disk, make sure the operating system is loaded before
you turn on your computer.

3. Turn on the computer.
It should come alive, showing the desktop after a while. If it doesn't, check
your SCSI setup.

4. Make sure Virtual Memory is Off, in the Memory Control Panel.
This is necessary for trouble-free audio playback. If Virtual Memory is On,
turn it off and restart the computer.

Finding your way on the
ReCycle CD-ROM

Once you have turned on your system, insert the ReCycle CD-ROM and open it
in the Finder. At the root of the CD-ROM, you will find a file called “Read Me".
Double click this to get information about what is what on the CD-ROM.

Installing the Acrobat
Reader

To be able to read the online documentation, you must have the Acrobat Reader
application installed. If this isn't already installed on your computer, you need to
install it from the ReCycle CD-ROM:

1. On the ReCycle CD-ROM, open the folder “Acrobat Reader” and
double click on the file “Reader Installer”.

2. Follow the instructions in the dialogs that appear.

3. At the end of the installation you may be required to restart your
computer again. Do so.

Installing ReCycle

1. On the CD-ROM, double click the icon named “Install ReCycle 2.0”.

2. Use the options in the dialog to select a destination and follow the
instructions on screen.

3. Click the “Install” button.

4. At the end of the installation you may be required to restart your
computer. Do so.

! Don’t launch ReCycle yet! You need to perform some additional
steps first:
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Setting Up The Sampler,
MIDI and SCSI

! Ifyou don’t plan to use ReCycle with an external sampler connected
via SCSI or MIDI, you can skip this section.

! The newer Macintosh models do not have built in SCSI. These mod-
els require a separate SCSI card to communicate with samplers via
SCsl.

1. Open the Sampler and File Format Reference (a document in Acro-
bat format in the ReCycle folder), look up the chapter that describes
your specific sampler, and check the heading “Support and Re-
quirements”.

2. If the sampler connection requires MIDI, turn to the OMS chapter in
the same document and install OMS as described there.

3. Again, please look up the relevant sampler chapter, and install and
set up the sampler as described there.

! Please read the section about your specific sampler thoroughly! If
your sampler communicates with the computer via SCSI, please
note that improper SCSI connections may cause permanent dam-
age to the computer, sampler and other SCSI peripherals.

Read the Read Me file!

In the ReCycle folder that was created on your hard disk during installation you
will find a file called Read Me. This will contain any late-breaking updates that
didn't make it into the manual. Please double click on it and read it before pro-
ceeding.

Register your software!

Please fill out and send in the registration card that comes in this package. Do-
ing so will make sure you are entitled to technical support and kept aware of up-
dates and other news regarding ReCycle.

Launching ReCycle

1. Locate your ReCycle program icon (in the new “ReCycle” folder on
the hard disk, not on the CD-ROM) and double click on it.

2. The program prompts you to insert the ReCycle CD-ROM (if not al-
ready in the drive).
This is only required the first time you run the program.

3. Adialog box appears, asking you to enter your name, company and
serial number. Do so, then click OK.
The serial number is printed on the Registration Card which is included in
the ReCycle package. Again, this procedure is only required the first time
you run the program.

4. Now, you will be asked whether the program should search for con-
nected samplers. If you have any samplers connected, click Yes; if
you plan to use ReCycle without samplers connected to the com-
puter, click No.

When ReCycle finds a properly connected sampler, it is automatically added
to the Sampler list. You can modify the Sampler list later if you wish to add,
remove or rename samplers. This is described on page 31.

! Not all samplers can be automatically found. Please check the Sam-
pler and File Format Reference for details of your specific model(s).

5. Finally, an Open dialog appears, asking you to locate an audio file
for opening.
This is the same dialog that appears when you select “Open” in the program
(see page 36). If you don't want this to automatically open when you launch
ReCycle, you can turn this feature off in the Preferences dialog.

Setting up Audio

ReCycle can play back audio directly from your computer, using the built-in Ma-
cintosh Sound Manager driver. Alternatively, if you have a sound card with a
dedicated ASIO driver, this is usually the optimal configuration.

If you want to use the internal audio in your computer, we recommend that you
connect the audio output on the back to your sound system instead of using the
Macintosh built in speaker.
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< Although the built-in sound capabilities on a Macintosh computer
are of a high standard, there are professional samplers that are ca-
pable of even higher quality sound reproduction. This means that
when you are auditioning audio directly from your Mac, this won’t
necessarily reflect the final audio quality in the sampler.

Audio Card Driver

After launching ReCycle, you should open the Preferences dialog on the Edit
menu and check the Audio Card Driver settings at the top. If you click the pop-
up, all available drivers installed are shown. The Apple Sound Manager is always
available as the Default output. The Audio Preferences changes appearance ac-
cording to whether an ASIO driver or the Apple Sound Manager is selected.

Preferences
Audio Card Driver
\/ [ Sound Manager Default Output i]
Sample Rate: 44100 ¥
Output Latency: 11 ms

Apple Sound Manager selected.

Preferences

Audio Card Driver

& [ASIO Audiowerk B

44100 ¥
[ Internal - Analog... i]

Sample Rate:

Clock Source:

Output Latency: 11 ms
[ Asio control Panel... | [

Output Channels... ]

ASIO driver selected.

If you select an ASIO driver, some additional items will be available in the Audio
Preferences.

< If the card and its driver supports it, the “Clock Source” pop-up al-
lows you to set an external source to which the audio playback can
synchronize its sample rate.
Please refer to the documentation that came with your card for details.

< The ASIO Control Panel may contain settings specific to your audio
card.
Please refer to the documentation that came with your card for details.

< If you have an audio card with multiple outputs, you can select
which output pair you wish ReCycle to use by clicking the “Output
Channels...” button.
This item will not be selectable if you use a card with only a regular stereo
output, or if the default Sound Manager driver is used.

Sound Manager or Dedicated ASIO?

ReCycle can either use the built-in Macintosh Sound Manager or a dedicated
ASIO driver to play audio. Basically, the following simple rule can be used as a
guide:

< If you have a sound card with a dedicated ASIO driver, you should
select this. Otherwise, use Sound Manager.
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System Information

When ReCycle is running, you will find an additional item on the Apple menu,
called “System Information”. If you select this item, a dialog will open, displaying
information about your computer and the SCSI and OMS configurations:

System Information

— General
Processar: PowerPC G3
Mac 05 Version: MacDS 9.0.4
Physical Mernory: 256.0 MB
Yirtual Mermory: off
— Audio
#udio Card Driver: | Default Output i]
Driver Type: Sound Manager Yersion: 1.0.0
— OMS
OMS Yersion: 237
Interface: [ IAC Driver i]
— SCs1
SCSI Manager 4.3 Installed? fes
Buses: [scsiManager 4.3 [MESH... | $ ]
[ copyto clippoard | [ ok ||
General

This section contains info about your computer's processor type, operating sys-
tem, physical memory and virtual memory.

Audio

This section shows information about all available audio card drivers.

omMs

This section contains information about the installed OMS version. By using the
pop-up menu, you can check which MIDI interfaces are available.

< It doesn’t matter which interface is “selected” on the pop-up menu.
The pop-up is only there for you to view the available interfaces.

SCsI

This section indicates whether SCSI Manager 4.3 is installed (required for SCSI
communication in ReCycle), and contains a pop-up menu where you can view the
available SCSI buses.

< Again, it doesn’t matter which SCSI bus is “selected” on the pop-up
menu. The pop-up is only there for you to view the available SCSI
buses.

Copy to Clipboard

Clicking this button copies the contents of the System Information dialog onto
the Macintosh clipboard. You can then paste this into a text file or an e-mail, e.g.
when contacting tech support.
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Memory setting and Audio
files

Every Macintosh program has a memory setting. This is used to tell the com-
puter how much RAM memory to reserve for a particular program. This setting
can be changed from the Finder as described below.

When ReCycle ships, you will be able to load 30 seconds worth of 44.1 kHz
stereo audio (or 60 seconds mono). This is a total figure which can be divided
by as many windows as you like.

In addition to this, more free memory is needed when you transmit samples to
your sampler.

If you find you need to increase the amount of memory dedicated to ReCycle,
proceed as follows:

1. If ReCycle is running, save the files you are working on.
2. Quit ReCycle.

3. Locate the ReCycle icon in the Finder and click on it once to select
it.

4. Select Get Info from the File menu.
Exactly what the dialog that appears looks like depends on what System
software version you are using. What you are looking for is the setting for the
maximum amount of memory that should be assigned to ReCycle.

5. Change the memory setting by clicking on it and typing in a new
value.
As a guideline, for each 100 kilobyte that you increase the setting with, you
will be able to load approximately one more second of mono audio.

6. Now, ReCycle will use this amount of memory, if it is available. If
there isn’t that much memory for it to “grab” (you might have other
programs running which already occupy some of your memory), it
will use as much as it can get. If the program can’t even find the
“minimum” amount of memory, it won’t start.

For more information about the memory settings in the Get Info dialog, see your
Macintosh manual.

Getting Help and
Additional Info

If you pull down the Contacts menu in ReCycle, you will find some menu items
that allow you to contact the manufacturers and get support:

Contacts Q;E0

Go to the Propellerhead Homepage
Download Drum Loops .
ReCycle Tech Info and Support
Order ReCycle Now

Register ReCycle Now

! For these items to be useful, you need to have a working Internet
connection and an Internet browser installed on your computer.

< Go to the Propellerhead Homepage
This menu item brings you to the homepage of Propellerhead Software,
where you will find information about possible new ReCycle versions, etc.

< Download Drum Loops
This menu item brings you directly to the Drum Loop page on the Propeller-
head web site. Here you can download various drum loops for free.

< ReCycle Tech Info and Support
This menu item brings you directly to the ReCycle Support pages on the
Propellerhead web site. Use this option if you are having trouble with ReCy-
cle and need help!

< Order ReCycle Now
This takes you to the “Prop Shop” where you can place orders for all cool
Propellerhead products.

< Register ReCycle Now
This is where you register your copy of ReCycle. Registering means that you
get access to product updates (when available), tech support and more.
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Requirements

To use ReCycle for Windows you need the following:

* AnIntel Pentium computer running at 66 MHz or faster.
A 800x600, 256 color monitor or better.

* A CD-ROM drive.

* 16 MByte RAM or more.

* A Windows compatible, 16-bit audio card.

*  Microsoft Windows 98 or NT 4.0 or later.

For communication with your specific sampler, you might also need:

* A Windows compatible MIDI Interface and cables, and/or...
* A 100% Windows compatible SCSI interface and cables.

Setting Up The Computer

Before proceeding, your computer should be set up and you should be reason-
ably familiar with its operation. You should also have the audio card installed and
working properly.

< To check whether your audio card works properly, try playing back
audio with the Media Player application (included with Windows).

! The quality of the sound during direct playback from ReCycle de-
pends fully on the audio card. If you have a not-so-good audio card,
this may mean that the sound quality during direct playback from
the computer isn’t immaculate. However, this does not reflect the fi-
nal audio in the sampler or in exported files, since this always main-
tains highest possible quality.

Depending on whether you plan to use a sampler, and the model of the sam-
pler(s), you may also need to install MIDI and/or SCSlI interfaces. See page 17.

Turning on your system

1. If you have any peripherals connected to the computer or sampler,
always turn these on first.

2. If you are using a sampler with the operating system on a floppy
disk or hard disk, make sure the operating system is loaded before
you turn on your computer.

Finding your way on the
ReCycle CD-ROM

Once you have turned on your system, insert the ReCycle CD-ROM and open it.
At the root of the CD-ROM, you will find a file called “Read Me". Double click
this to get information about what is what on the CD-ROM.

Installing the Acrobat
Reader

To be able to read the online documentation, you must have the Acrobat Reader
application installed. If this isn't already installed on your computer, you need to
install it from the ReCycle CD-ROM:

1. Insert the ReCycle CD-ROM.

2. Onthe CD-ROM, open the folder “Acrobat Reader” and double click
on the application file “rsxxx.exe” (where “xxx” is the version of the
Acrobat Reader, e.g. “4.05”).

3. Follow the instructions in the dialogs that appear.
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Installing ReCycle

1. On the CD-ROM, double click the icon named "Install ReCycle".
Follow the instructions in the dialog boxes that appear.

3. At the end of the installation you may be required to restart your
computer. Do so.

! Don’t launch ReCycle yet! You need to perform some additional
steps first:

Setting Up The Sampler,
MIDI and SCSI

! If you don’t plan to use ReCycle with an external sampler, you can
skip this section.

1. Open the Sampler Supplement (a document in Acrobat format in
the ReCycle folder), look up the Appendix that describes your spe-
cific sampler, and check the heading “Support and Requirements”.

2. If the sampler connection requires MIDI, you need to have a MIDI in-
terface installed and working.
To install a MIDI interface, follow the instructions in the manual that came
with it. Make sure to install the latest driver for the interface.

3. If the sampler connection requires SCSI, you need to have a SCSI
interface installed and working (see “Installing SCSI” below).

4. Again, please look up the relevant sampler Appendix, and install
and set up the sampler as described there.

! Please read the section about your specific sampler thoroughly! If
your sampler communicates with the computer via SCSI, please
note that improper SCSI connections may cause permanent dam-
age to the computer, sampler and other SCSI peripherals.

Installing SCSI
ReCycle works with any SCSI host adapter that is 100% Windows compatible.

! Do not connect anything to the SCSI card until you have finished in-
stallation of the card and its drivers. Also read the section in the on-
line Sampler Supplement document about your specific sampler
thoroughly before making any SCSI connections.

About SCSI IDs

The SCSI host adapter itself normally has its SCSI ID set to 7. This means that
no other device can be set to SCSI ID 7.

Verifying SCSI Communication with the Sampler

The SCSI communication between the computer and the sampler can be
viewed as two different links: the communication between the SCSI host
adapter and the sampler, and the communication between Windows and the
SCSI host adapter. Both these links need to be verified.

If any of the verifications below fail, you need to check your SCSI
connections and settings and try again. Again, make sure you have
read the section about your sampler in the online Samplers docu-
mentation.

Verifying that the SCSI Host Adapter “sees” the Sampler

When you turn on your computer after having connected and booted the sam-

pler, look at the initial BIOS information displayed on screen (before Windows is
started). When the BIOS of your SCSI host adapter starts, you will note that it

scans the SCSI bus for connected units. If your sampler is properly connected

and running, the SCSI host adapter should find it and display its name briefly.
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Verifying that the Sampler is registered by Windows

When Windows starts you should get an alert saying that “Windows has found
new unknown hardware”. This indicates that Windows has found your sampler.
The “Add New Hardware Wizard" will then appear, asking you to install device
drivers for the hardware. Proceed as follows:

1. On the first page of the Wizard, just click “Next”.

2. Next, select the option “Search for the best driver for your device”
and click “Next”.
The Wizard will now display a page with options for where Windows should
look for the new driver (floppy disk, CD-ROM, etc.).

3. Make sure none of these options are selected, click “Next” and then
“Next” again.
The Wizard will now inform you that Windows hasn't installed a driver for the
device, which is precisely what we want.

4. Click “Finish”.

! Depending on the type of sampler, the “Unknown Hardware” alert
may be shown again and you may have to perform the steps above
several times. This is perfectly normal - just go through with it. You
will only have to do this the first time you start the computer with
the sampler connected.

Read the Read Me file!

In the ReCycle folder that was created on your hard disk during installation, you
will find a file called Read Me. This will contain any late-breaking updates that
didn’t make it into the manual. Please double click on it and read it before pro-
ceeding.

Register your software!

Please fill out and send in the registration card that comes in this package. Do-

ing so will make sure you are entitled to technical support and kept aware of up-

dates and other news regarding ReCycle.

Launching ReCycle

1. Locate the ReCycle entry on the Start menu and select it.

2. The program prompts you to insert the ReCycle CD-ROM (if not al-
ready in the drive).
This is only required the first time you run the program.

3. Adialog box appears, asking you to enter your name, company and
serial number. Do so, and click OK.
The serial number is printed on the Registration Card which is included in
the ReCycle package. Again, this procedure is only required the first time
you run the program.

4. Now, you will be asked whether the program should search for con-
nected samplers. If you have any samplers connected, click Yes; if
you plan to use ReCycle without external samplers, click No.

When ReCycle finds a properly connected sampler, it is automatically added
to the Sampler list. You can modify the Sampler list later if you wish to add,
remove or rename samplers. This is described on page 32.

5. Finally, an Open dialog appears, asking you to locate an audio file
for opening.
This is the same dialog that appears when you select “Open” in the program
(see page 36). If you don’t want this to automatically open when you launch
ReCycle, you can turn this feature off in the Preferences dialog.
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Audio Settings

After launching ReCycle, you should open the Preferences dialog on the Edit
menu and check the Audio Card Driver settings.

Preferences

Audio Card Driver

Ok I
Sample Rate: [44700 | _ Coneel |
Clock Source: ISoundscape Mixer 'l _IHElD
Output Latency: 13ms

ASI0 Control Panel... | Ouput Channels... |

The Audio Preferences with an ASIO driver selected.

Selecting an Audio Card Driver

The first thing to do is to select a driver for your audio card. All available drivers
are listed on the Audio Card Driver pop-up menu. Select after the criteria listed
below:

< If you are using audio hardware for which there is a specific ASIO
driver, you should select this.
With an ASIO driver written specifically for the audio hardware, ReCycle can
communicate more or less directly with the audio hardware.

If you select an ASIO driver, some additional items will be available in the Audio
Preferences:

< If the card and its driver supports it, the “Clock Source” pop-up al-
lows you to set an external source to which the audio playback can
synchronize its sample rate.
Please refer to the documentation that came with your card for details.

< The ASIO Control Panel may contain settings specific to your audio
card.
Please refer to the documentation that came with your card for details.

< If you have an audio card with multiple outputs, you can select
which output pair you wish ReCycle to use by clicking the “Output
Channels...” button.
This item will not be selectable if you use a card with only a regular stereo
output.

< |If there is no specific ASIO driver, you should select the Direct
Sound driver for the audio hardware.
This makes ReCycle communicate with the hardware via Direct Sound (a
part of the Microsoft DirectX package). For this to be possible, you need to
have DirectX installed on your computer, and there must be a Direct Sound
driver for the audio hardware. The Audio Preferences dialog changes ap-
pearance if a Direct Sound (or MME) driver is selected.

Preferences

Audio Card Driver

ak. I
Sample Rate: |441 oo ,l ﬂl
Buffer Size: .—J— Help |
Output Latency: 92 ms

The Direct Sound driver for a Creative SoundBlaster PCI card selected.

< If the audio hardware doesn’t support Direct Sound (i.e. there is no
Direct Sound driver for the audio hardware), select the MME driver
for the audio hardware.
This makes use of Windows Multimedia Extensions, the part of Windows
that handles audio, MIDI, etc. Using MME may result in a noticeable /atency,
causing the audio playback to be slightly delayed. In the case of ReCycle,
you would notice this in that playback started slightly after you clicked the
Play button, for example.

Regardless of which type of audio hardware or drivers you are using, you should
follow these basic steps:

1. Make sure you have the latest drivers for the audio hardware!
Please check the manufacturer's website for the latest versions.

2. Install the audio hardware and its drivers as described in its docu-
mentation.

3. Connect the stereo outputs of your audio hardware to your listening
equipment (speakers, mixer, headphones or similar).

4. If possible, test that audio plays back properly with the audio hard-
ware.
In the case of audio hardware with ASIO drivers, you will need some test ap-
plication for this (often included with the audio hardware). If you are using Di-
rectX or MME drivers, you can use Windows' Media Player application for
this.
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Setting the Audio Card Buffer

ASIO

If an ASIO driver is selected, there will be no “Buffer Size” slider in the Prefer-
ences dialog.

< If you are using an ASIO driver specifically written for the audio
hardware, you can in some cases make settings for the hardware by
clicking the Control Panel button.
This opens the hardware’s ASIO Device Control Panel, which may or may
not contain parameters for adjusting the number and/or size of the audio
buffers - the fewer and smaller the audio buffers, the lower the latency.

Please consult the documentation of your audio hardware and its ASIO driv-

ers for details!

DX/MME

For DirectX or MME drivers, it is important that you trim the buffer setting prop-
erly. The buffer setting is a balance between fast response to playback com-
mands on one hand and “safe” audio playback on the other.

1. Select “Open” from the File menu.

2. In the dialog that appears, navigate to the ReCycle program folder.
Make sure the “All Files” option is selected on the “Files of type” pop-up
menu.

Open the file “Drum Tools Demo.aif”.
Activate Playback by clicking the Play button.

Open the Preferences dialog from the Edit menu.

L

In the Preferences dialog, locate the Buffer Size slider and drag it
all the way to the right.

J—

Buffer Size:

The Buffer Size slider.

7. Now drag the Buffer Size slider to the left, a bit at a time. Try posi-
tions further and further to the left, until the sound starts ”breaking
up”.

8. Drag the slider a little bit to the right, so that the sound is OK again.

9. Close the dialog.

You are now finished with your audio settings for ReCycle. The settings you just
made are stored automatically.

Getting Help and
Additional Info

If you pull down the Help menu in ReCycle, you will find menu items for getting
help, support and information:

Help

Lontents
Index
Search

the Propellerhead Homepage
Download Dium Loops k
FieCycle! Tech Info and Support
Order ReCyclel Mow
Fegister BeCyclel Mow

Syztem |nformation. ..
About ReCyclel...

??

Help Contents

< If you select “Contents” the Help Contents appears. The on-line
help contains descriptions of all menu items, allowing you to
quickly find the desired item.
You can also perform a keyword search.

< You can also get help by clicking the Help button or [F1] in ReCycle
dialogs to get specific information about each dialog.

< Pressing [F1] (with no dialog open) will launch help for the main
ReCycle Window where you can click on the item or section you
want to know more about.
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Contacts System Information

The next items on the Help menu allow you to contact Propellerhead Software If you select this item, a dialog will open, displaying information about your com-
for support and more info. puter and the MIDI and SCSI configurations:

! For these items to be useful, you need to have a valid Internet con-

nection and an Internet browser installed on your computer.  General
Windows Yersion:  Microzoft Windows 38 4.010 [Build 2222)

< Go to the Propellerhead Homepage...

This menu item brings you to the homepage of Propellerhead Software, P — e

where you will find information about possible new ReCycle versions, etc. Physical Memary: 28,0 ME
% Download Drum Loops... Direct< Version: Direct< 6.1

This menu item brings you directly to the Drum Loop page on the Propeller- ~ fudio

head web site. Here you can download various drum loops for free. Audio Card Driver: | Creative SBPCI Direct Sound Driver j
d Re.cyde T.eCh In.fo and quport"' Diriver Wersion: n/a Driver Type: DX

This menu item brings you directly to the ReCycle Support pages on the

Propellerhead web site. Use this option if you are having trouble with ReCy- ~MIDI

cle and need help! Ports: |[|nput] SB AudioPCl 128 MIDI In j
< Order ReCycle Now Drriver Yersior: 4.56

This takes you to the “Prop Shop” where you can place orders for all cool

Propellerhead products. rsts!

ASP| Installed: Yes ASPI Wersion: 1,0.0.1

< Register ReCycle Now

This is where you register your copy of ReCycle. Registering means that you ey |45t for WING2 ESDL_506] =l

get access to product updates (when available), tech support and more.

Copy to Clipboard | Help |

< You cannot change any settings in this dialog - it is only there to
give you information.
The pop-up menus are really just lists of installed drivers.
General
This section contains info about your computer’s processor type, Windows ver-
sion, physical memory and DirectX version.

Audio

This section contains a list of the available Audio Card Drivers. If you select one
of the drivers from the pop-up menu, the version and type (ASIO/MME/DirectX)
of the driver are displayed below.

MIDI

This section contains a list of the available MIDI ports. If you select a port with
the pop-up menu, its driver version is displayed below.
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SCsI

This section indicates which version of ASPI (the protocol for SCSI communica-

tion under Windows) is installed. The pop-up menu contains a list of the avail-
able SCSI buses.
Copy to Clipboard

Clicking this button copies the contents of the System Information dialog onto
the Windows clipboard. You can then paste this into a text file or an e-mail, e.g.
when contacting tech support.

About ReCycle

Selecting this item brings up a dialog listing the fine people involved in creating
this program.
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How ReCycle Works

There are many things you can do with ReCycle. But the most common applica-
tion is to slice a loop for tempo changes or editing. These are the basic steps
(details follow later in this chapter):

1. Load the loop in from your sampler, or, if you have the loop as an
audio file on your hard disk, open it.
The program now analyses the loop and detects the individual “hits” or
“sounds” in it. It then displays the loop in the waveform display.

2. The second step is to work with the Sensitivity slider and the tools
to set up a number of slices.
Each slice represents an individual sound in the loop. Slices are displayed
as vertical lines across the waveform.

3. The slices are now used for setting up loop points using the left and
right locators. Play back the audio to check that the loop is correct.
The loop settings are used by ReCycle to calculate the tempo of the sam-
pled loop, among other things.

4. Once you have set the loop points, you can enter the length of the
loop in Bars/Beats, and change the Time Signature if required.
Finish by pressing [Return], and the original tempo will be calculated and
displayed on the toolbar according to the settings made.

5. Now you can enter Preview mode, and change the tempo and pitch
independently, add processing and much more.
Everything you do in Preview mode will be present in the resulting REX2 file
or when transferred to your sampler - what you hear is what you get.

Once you have tweaked the loop to your liking in Preview mode it's time to put
the loop to use. At this point the procedure is different depending on whether
you are using ReCycle with a sampler or in conjunction with another computer
program that can read REX2 files (such as Propellerhead Reason or Steinberg
Cubase):

Transferring and Using the Loop in a Sampler

1. First you need to transmit the sliced-up loop back to the sampler.
Only this time, each slice is transmitted as an individual sample.
The samples are automatically mapped across the “keyboard” in the sam-
pler, chromatically. This means that if you play the new samples in succes-
sion, you get the original loop back. This would be very hard to do by hand,
SO...

2. Next, let the program create a MIDI file that will play the slices, one
after the other each with the correct length.

3. Once all this is done, you are finished with ReCycle. Now you load
the MIDI file into your sequencer program and play it back from
there.

This will perfectly recreate the way the loop originally was. But now that the
loop is broken down into slices, you can change the tempo in the sequencer
and the loop will follow. You can also perform detailed editing, quantizing
and other operations on the MIDI file. This will be equivalent to editing the
loop, since each note in the MIDI file directly represents a sound in the loop!

Using the Loop in another Program

1. Save the Loop.
This operation produces a REX2 file, the native file format used by ReCycle.
REX2 files contains both the audio data of the loop, the slice information and
the original (calculated) tempo.

2. Launch the program (Cubase for example), and import the REX2 file
onto an Audio Track.
The slices will now appear in their correct order and positions, and you will
be able to change tempo and manipulate the slices much like when using a
sampler.

! The handling of REX2 files in Cubase is described in detail on page
78.

On the following pages you will find a quick tutorial. After this are handling in-
structions for all different aspects of the program. In the chapter “Example Appli-
cations” you will find more practical examples of what you can do with ReCycle.

About ReCycle and Reason

Reason, another program by Propellerhead Software, features a dedicated Re-
Cycle file player (Dr. REX). In addition to playing back ReCycle files, Dr. REX al-
lows you to further process files with various synth parameters, to change the
pitch of individual slices and much more. The Reason sequencer also has a sep-
arate REX editor for editing slices.
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H R I s B 4. In the window, click the Play button.
USI ng ecyc e - tep y You should now hear the entire loop, from start to end, repeating until you
click the Stop button. As you can hear, the Drum Tools Demo loop has “dou-
step ble” downbeats, it starts on a downbeat, and ends on a downbeat, which
means that two downbeats are played in succession when the file is looped.

. We shall fix this shortly - now proceed.
The text below assumes that you have installed ReCycle and a sequencer pro-

gram such as Cubase and that all connections to your sampler are set up and Stop Play
working. If not, please see the Installation chapter for more information. —1 l_
1. Launch ReCycle by double clicking on its icon.
The Open dialog may appear, depending on the setting the Preferences di- IEE
alog. If not, select Open from the File menu.
5. Drag the Sensitivity slider to the right, until its value is between 70
and 80 and a number of lines appear.

3. Select the file and click Open. We call those lines and their triangle symbols “slices” since they indicate
You will be asked whether you want the Left Locator to be moved to the first that the sound has now been cut up into slices.

Slice point (see page 39 for more info). Click Yes. = -ﬂ | cons. - | ot Sos QDT’f | o

2. Locate the file called “Drum Tools Demo.aif” in your ReCycle folder.

[0 =———Drum Tools Demo.aif * =—"—"——= 015 Sensitivity amount
- =, | Attack QD ms  Decay anfs

Drum Tools Demo.aif =

| |
R W PO Y

The Drum Tools Demo loop.

The Sensitivity Slider and some slices.

6. Position the mouse pointer over the “L” handle (the Left Locator)
and drag it to the left a bit and release it.
As you will see, it winds up exactly on one of the slices, and on the next lap,
playback starts from this point.
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7. Drag the Left and Right Locators until the loop is exactly 1 bar long.
The left locator should be positioned at the start of the loop, on the first slice
marker, and the right locator should positioned on the last slice marker. This
last slice contains the “extra” downbeat (see step 4), but as the Right Loca-
tor position governs when the loop should jump back to the Left Locator, this
second downbeat won't be played, and the loop will now be exactly 1 bar.

fLoorir )

23
i)

| |
The Locators set up correctly.

8. With playback turned off, move the pointer over the waveform view.
The pointer changes to a speaker symbol.

9. Click with the Speaker pointer on the slices in the waveform view.
You will hear each individual sound in the loop. The slice you clicked last is indi-
cated by a dotted vertical line to the left - this slice is called the Current Slice.
You can also drag the pointer over the slices with the mouse button pressed to
audition the sounds in the loop.

10. Click in the “Bars” field, type “1”, and hit [Return].
The calculated tempo is now shown as the “Orig. Tempo” on the Toolbar.

Bars: | 1 + Beats: [ 0 :ISign: 4/4 :I Orig. Tempo: 79666 BPM
Tempe () | 130.000 | BPM

The Bars/Beats settings, the (calculated) Original Tempo and the Preview Tempo field.

11. Click on the Preview Toggle button.
Preview mode is now activated.

=a

Now you can make various settings to the loop, and hear the results in real-time.
Preview mode lets you hear exactly how the loop will sound after being saved as
a file or transmitted to your sampler:

< By adjusting the Preview Tempo knob or typing in a new tempo di-
rectly in the Preview Tempo field, you can change the tempo of the
loop.

If you intend to play back the loop as a REX2 file in a sequencer, or if you
transmit the loop to a sampler together with a MIDI file, the loop will follow
the tempo setting of the sequencer, regardless of this setting!

< By adjusting the Pitch knob you can change the pitch of the loop.

There is a Gate function which can be used to remove all sound in a
loop that falls below a set threshold.
This is described on page 67.

- In addition there are three effect processors; Envelope, EQ and
Transient Shaper, that allow you to further tweak the sound of the
loop before transmitting it to your sampler, or exporting/saving it
as a file.

The processors are described in the chapter “Processing Audio”.

12. Pull down the Process menu and check the Transmit options (the
items “Transmit as One Sample” and “Silence Selected”). They
should be turned off (no tick mark).

The status of the Transmit options can also be toggled by using the Transmit
option buttons on the Toolbar.

! Ifyou don’t use ReCycle together with a sampler, but rather with an-
other computer program such as Reason or Cubase, you could at
this point simply save the sliced-up loop as a REX2 file and import
this file into the program. This is described on page 78.

So, now we have everything we need, a perfect loop, a tempo, possibly some
audio processing parameters, and a good set of slices. Let's send this stuff to
the sampler.

13. Pull down the Sampler menu and select the sampler you want to
use, at the bottom of the menu.
The available options on this menu depends on which samplers you have
added to the Sampler List, manually or automatically, as described on page
30.

! If you are using a file-based sampler such as SampleCell or a
SoundFont compatible soundcard, you t can use the Export dialog
on the File menu to save files in these formats. See page 76.
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14. Pull down the Sampler menu and select the top item on the menu 6. If you want to, you can also try customizing the loop by editing, re-
(“Transmit to...”), depending on what you selected in the previous arranging and duplicating the events in the sequencer.
step).
A dialog box opens. Exactly what the dialog looks like depends on the sam-
pler. As an example, we're showing the Yamaha A3000 dialog.

7. In the sampler, try re-tuning samples, altering envelopes, sending
samples to different outputs, panning etc.

Transmit to My A3000 via MIDI+SCS1

Sample Bank Name: IDrum Tools Demd I

Sample Rate: [ 44.1kHz

o]l

Template: [ [Default]

Cancel I Transmitl MIDI File + Transmit... II

15. Click “MIDI File+Transmit” (or “MIDI File+Export” depending on
what you selected in step 14 above).

Now the following happens:

< The slices get transmitted to the sampler.
For details, see page 71.

< Aregularfile dialog box appears allowing you to position and name
the MIDI File (we will later use this file to play back the loop). Save
the file.

Now we are actually done with ReCycle for a while. Let's start using the stuff

that the program produced for us.

1. You will only need to make sure that the “Program” (or whatever it
is called) that was created, is selected in the sampler and that the
instrument is receiving on the MIDI channel of your choice.

2. Launch your MIDI Sequencer and make sure you are also transmit-
ting correctly to the sampler (set the MIDI Output and MIDI Chan-
nel).

3. Play your keyboard to check the material in the sampler. You will
note that each key plays a slice. What was previously one long re-
cording is now a number of short snippets spread out over the key-
board. If you play the keys chromatically upwards, the loop will be
recreated (although probably not with perfect timing!).

4. Load the MIDI file you just saved to disk into your sequencer pro-
gram. Set it to output to the sampler and start playback.
The loop will play back as it originally did.

5. Try changing the tempo in the sequencer.
The fact that you can lower the tempo without the loop sounding “chopped
up” is thanks to the Stretch setting in ReCycle. See page 63 for details.
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Exporting to File

Besides creating REX2 files for use in audio sequencers, or transmitting sepa-
rate slices to samplers, ReCycle can be used to simply change the inherent
properties of a file, like the tempo and/or the pitch for example. You can then ex-
port the loop (as one sample - not as separate slices) and use it in any audio ap-
plication or sampler.

A typical example would be a situation where you have found a perfect loop you
wish to use in a song you have recorded. The problem is that the tempo of the
loop is wrong, and you don't wish to change the tempo of the song to accommo-
date the loop, Let's further assume that the song has been recorded using a
hard disk recording system that cannot import REX2 files, and you don't have a
sampler.

The simple answer is if the loop you want to use can be opened in ReCycle, you
don't have a problem! Proceed as follows:

1. Open the file in ReCycle and use the normal techniques to add an
appropriate amount of slices, set the number of Bars and Beats etc.
(to calculate the original tempo) and then enter Preview mode.
Note that even though you will export the file as one sample, you still have to
slice the file!

2. In Preview mode, simply type in the Preview Tempo to match the
song tempo, and/or change the pitch to fit the song.
Naturally, you can also add equalization, or any of the other Effects or pro-
cessing functions if you like.

3. Activate “Transmit as One Sample” on the Process menu.

Use the Export File dialog (see page 76) to save the file in it’s origi-
nal format.
The resultant file will now match the songs tempo and/or pitch perfectly!

Congratulations! You just tried out some of the basic capabilities of your new
program! Of course, there's a lot more to learn and discover. Please proceed to
the following chapters to find out about all the capabilities of this amazing pro-
gram!
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The Sampler Settings
dialog

! If you are not using ReCycle with a sampler connected to the com-
puter, you can skip this chapter.

For file-based samplers (SampleCell, Mixman or SoundFonts) and
the AKAI S5000/S6000 series, this dialog is not used. See the
“Sampler and File Format Reference” Acrobat documentation for
details.

Sampler Settings
sampler: [ My CD3000XL via SCS| =]

Name: My COZ000XL via SC3I
MIDIIn: | 2
MIDI Qut: | 3]
SysEx ID: [Z] Required 05:  ¥2.00

Found 05 ¥2.00
SCSIBus: [SCSIManager4.3 (2] | Stereo Support: Yes
SCSIID: [4 i] Hotes: Ho infarmation available
“ Check that sampler is on-line.

[_Add.. | [ FindAn.. | [ Delete | -

The Sampler Settings dialog on the Edit menu is where you set up and edit the
Sampler List. The samplers you have included on this list will be available on the

Sampler menu in the main ReCycle window, for transmit and receive operations.

m Windows Contacts Help
Transinit to My CD3000XL via 5C51 T

Receive from My CD3000XL via SC51 3R
+ My CD3000XL via 5CS1

My E51-32 via 5C51
My 53200 via SCS1

The items on the bottom of the menu are taken from the Sampler List.

! That a sampler is on the list doesn’t mean it’s set up correctly or
even connected to the computer! ReCycle doesn’t automatically re-
move samplers from the list if they are not connected. You may
temporarily disconnect your sampler between sessions, without
having to set it up in ReCycle again.

Finding all Connected Samplers

There are special considerations regarding the following sampler models or set-
ups:

< Ensoniq samplers (all models).
These cannot be automatically found by ReCycle.

< Generic SDS and SMDI (Generic and Extended).
These cannot be automatically found by ReCycle.

< Multiple instances of the same model samplers that require a MIDI
connection for SCSI transfers (i.e Kurzweil K2000/Yamaha A3000/
Roland S-760).

There may be problems if you have two or more of the above mentioned
sampler models (that is, two or more instances of the same model) con-
nected via MIDI, and one of these is also connected via SCSI.

In all the above mentioned cases, you should instead add the samplers manually,
see page 31.

ReCycle can scan the SCSI and MIDI connections and automatically add all
properly connected samplers to the Sampler List:

1. Open the Sampler Settings dialog.
You should have turned on and booted all connected samplers before you
turned on the computer and launched ReCycle.

2. Click the “Find All...” button at the bottom of the dialog.
ReCycle scans for samplers.

3. When a properly connected sampler is found (that isn’t already on
the Sampler List), you will be asked if you want to add it to the list.
Click “Yes" to add the sampler to the list.

4. If a sampler is found, that is already included on the Sampler List,
ReCycle will tell you this.
Click “Skip” to continue the search.

! ReCycle will only find one sampler of each model - if you have more
than one sampler of the same model connected, you need to add
these manually (see page 31).
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< If a sampler is found, that isn’t properly connected, ReCycle will in-
form you of this and tell you what you need to do.
For example, you may have a Yamaha A3000 sampler connected via SCSI
only. The program will find it, but since this sampler requires a MIDI connec-
tion, it will not be added to the Sampler List. Instead you will be asked to
check your MIDI connection and MIDI interface.

Once the Find All process is complete, all properly connected samplers have
been added to the Sampler List (provided that you clicked “Yes" for each one of
them in step 3 above). You can check this by pulling down the Sampler pop-up
menu at the top of the dialog.

LT T A~ My CD3000XL via SCS1

My E51-32 via 5C51
My 53200 via SCS1

Name:

You can now rename and edit the settings for samplers on the list, as described
below.

Adding a Sampler Manually

You can manually add a sampler to the Sampler List at any time, regardless of

whether the sampler is connected or not. This is useful if you want to set up your
system before you connect your samplers, or if you have several samplers of the
same model connected (since ReCycle only “finds” one sampler of each model):

1. Click the “Add...” button at the bottom of the Sampler Settings dia-
log.
The Add Sampler dialog appears.

Add Sampler

Model: [ AKAI 53000 via MIDI B

Information

Required 05: Ya2.00
Stereo Support: fes
Hotes: Mo information available.
[ Find.. || [ cancel | [ ok |

2. Use the Model pop-up menu to select the sampler model you want
to add.
Note that each actual sampler model may have more than one entry on the
pop-up menu, if there are different ways to connect the sampler (e.g. via
MIDI or via SCSI).

! There are special considerations for some E-mu samplers - please
read the E-mu chapter in the Sampler and File Format Reference
online document!

3. If you know that the sampler is connected and booted, click the
“Find...” button.
ReCycle scans the MIDI and/or SCSI connections for a sampler of the se-
lected model. If it finds one, you are asked whether you want to add it to the
Sampler List. If you click “Yes", the sampler is added to the list with the cor-
rect SCSI ID and/or MIDI SysEx ID settings.

! Please note that ReCycle will only find one sampler of each model -
if you have more than one sampler of the same model connected,
you need to add these by clicking “OK” instead, and adjust the
MIDI/SCSI settings manually in the Sampler Settings dialog, as de-
scribed on page 32.

4. To add a sampler without “finding” it, click OK.
A sampler of the specified model is added to the Sampler List, with default
values for SCSI and/or MIDI settings. You will probably have to change the
SCSI and/or MIDI settings manually later.

About the Generic SDS and SMDI Samplers

! Samplers that may be compatible with the Generic SDS/SMDI and
Extended SMDI formats cannot be automatically “found” by ReCy-
cle, nor can the connection be verified! To check if these protocols
for transferring samples works with your sampler is a matter of trial
and error (see the Sampler and File Format Reference documenta-
tion for details).

These are not samplers as such, but rather protocols for transferring samples

between two devices. If your sampler model isn't supported by ReCycle you

may still be able to transfer audio files using one of the generic sampler formats.

» SDS stands for “Sample Dump Standard”, and is a protocol for transfer of
sound sample data between devices via MIDI.

* SMDI stands for “SCSI Musical Data Interchange” and could be described
as “SCSI SDS", i.e.the purpose of the SMDI protocol is to use the superior
data transfer ability of SCSI to serve the same purpose as SDS.
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Common to both protocols is the ability to send samples between any two de-
vices in a commonly recognized format. See the “Sampler and File Format Ref-
erence” online document for details.

Adding an Ensoniq Sampler

For technical reasons, Ensoniq (and other sampler models in some cases - see
page 30) samplers cannot be automatically “found” by ReCycle. This means you
have to add Ensoniq samplers manually, without “finding” them (by clicking OK
in the Add Sampler dialog as described above), and then adjust the MIDI set-
tings in the Sampler Settings dialog.

! Make sure the Ensoniq sampler isn’t in “Load Mode”, as this will
disable MIDI communication!

Verifying the Connection with a Sampler

Near the lower left corner of the Sampler Settings dialog, you will find a small
icon next to a “Verify” button. The icon indicates whether the currently selected
sampler on the Sampler pop-up menu is properly connected (on-line) or not.

For example, if you add a sampler manually without using the “Find” function, the
icon will be a red cross, indicating that the sampler isn't on-line. If the selected
sampler is found automatically by ReCycle, the icon will be a green check mark,
indicating that the sampler is on-line.

v | x e

Sampler on-line. Sampler not on-line.

< To update the status of the icon and check the connection to the
currently selected sampler, click the “Verify” button.
For example, you may want to do this after having changed SCSI or MIDI
settings, as described below.

< Each time you launch ReCycle, the program automatically Verifies
the connection with all samplers on the Sampler list.
If a sampler isn't on-line, it will not be available on the Sampler menu.

Making Settings for a Sampler

In the area to the left in the Sampler Settings dialog, you can adjust the settings
of the currently selected sampler. There are three sections:

< Name.
This shows the name of the sampler as it will appear on the Sampler menu in
the main ReCycle window. If you wish to rename it, click the “Rename...” but-
ton and enter a new name.

< MIDI settings.
If the selected sampler uses a MIDI connection, you will find settings for
MIDI In/Out ports and SysEx ID. To change these settings, use the respec-
tive pop-up menu.

< SCSI settings.
If the selected sampler uses a SCSI connection, you will find settings for
SCSI Bus and SCSI ID. To change these settings, use the respective pop-
up menu.

! If you change the MIDI or SCSI settings manually this way, you
should always use the Verify function to check that the sampler is
on-line.

Read the Sampler Information!

Type: Akal CDI000XL via SCSI

Required 05: ¥2.00

Found 05: Y¥e.on
Stereo Support: Yes
Hotes: Ho information available.

When a sampler is selected (on the Sampler pop-up menu), you will see an im-
age of its front panel displayed to the right in the Sampler Settings dialog, along
with model and connection information. Below the image, you will also find the
following information:

< Required OS.
This is the operating system required for the sampler to work with ReCycle.

% Found OS.
This is the operating system currently used by the sampler. If this is an older
OS version than the “Required OS”, you need to upgrade the sampler.

< Stereo Support
This tells you whether the sampler supports stereo audio files or not.

% Notes.
Under this heading you may find additional important information.
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Deleting a Sampler from the list

If you wish to remove a sampler from the Sampler List, proceed as follows:

1. Pull down the Sampler pop-up menu and select the sampler you
want to remove.

2. Click the “Delete...” button at the bottom of the dialog.

3. Click “Yes” to confirm that you want to remove the sampler.
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About Sounds and
Memory

Whenever ReCycle displays audio in a window, it has to load it into the com-
puter's RAM memory.

MacOS Note: If you want to be able to load a lot of sound files or if you want to
have many windows open at the same time you will need to assign the program
more memory. See page 14 for more info.

How much audio you can load into the program at one time depends on how
much memory you have in your computer (total) and how much of it that other
programs are currently using. If the program tells you there is not enough mem-
ory for a certain operation, or if you can't open an audio file (in any of the sup-
ported formats), the first thing to try is to quit other programs.

You can open files (mono or stereo) that are up to five minutes in length, if you
have enough memory for it. To open a five minute stereo file ReCycle has to have
access to 52 MByte of memory. Please note though, that Transmitting audio re-
quires even more memory (the exact amount depending on the length of the
Slices and the Stretch factor).

About REX2 Files

REX2 is the native file format of ReCycle. Saving a file in this format will signifi-
cantly reduce the size of the file. This is achieved by applying a compression al-
gorithm to the file when saved. The compression is “non-lossy” meaning that it
does not compromise the audio quality in any way. How much the file will be
compressed compared to the original size depends on the complexity of the au-
dio and other factors. When you open a REX2 file, the file information in the
Open dialog will tell you how much the size has been reduced, expressed as a
ratio (see page 37).

Using Open

B clnlo]
Date Modified |=
K l=ri Tl

JustLoop AIF 26/4/00
LoopReérr AlF 26/4/00

[5 Mova Fill Single.aif 17/2/00 B

L= Rhythmatron 2747400 _

Ig sTaTAS WAV 17/2/00 -

synth_treated.AIF 26/4/00 vy

& synt_oro.AlF 2674400 =]

File Information ReCycle Information
Type: Audio IFF Tempo: n#a
Channels: 2 Sign: n#a

Length: 6.01s Length: n#a

Bits: 16 Usage: n#a b Auto Play
Freq: 44.1 kHz Slices: n#a
Size: 1.0 MB Exp. Size: nda
[ Cancel ] H Open ]l
Z

The Open dialog.
The Open item on the File menu is used to load audio files from the hard disk.
The dialog box is a standard file dialog with some additions.

! By default, this dialog will appear automatically when you launch
ReCycle. If you don’t want this, open the Preferences dialog on the
Edit menu, and deactivate the “Show Open Dialog on Startup” op-
tion.
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File Information

When you select afile in the list, information about file type, length, etc. is shown
in the lower part of the Open dialog.

File Information ReCycle Information

Type: REXZ File Tempo: 100.0 BPM

Channels: 1 Sign: 4/4
Length: 5.02s Length: 2.0 Bars

Bits: 18 Usage: 100 % b Auto Play
Freq: 44.1 kHz Slices: 23

Size: 296 kB (2.4:1)  Exp. Size: 1.0MB

The File information.
For all recognized audio file formats, the following information is displayed:

* File Type (see “File Formats” next page).

*  Number of channels.

* File Length.

* Bit depth.

¢ Sample Frequency.

» File Size, in Bytes (For REX2 files the data compression ratio is displayed in
parentheses. In the picture above, 2.4:1 means that the file was 2.4 times
larger before it was compressed).

If the file is a ReCycle file, the following additional information is displayed:

*  Tempo.

« Time signature.

¢ Length in bars and beats.

« Usage, which tells you the size of the loop (i.e the audio between the loca-
tors) in relation to the total file size in percent.

«  The number of slices in the file (only available if a REX2 file is selected).

*  Export Size tells you the size of the file if transmitted/exported (only available
if a REX2 file is selected).

Play and Stop buttons

When you click the Play button, the selected file will be played back looped until
you press Stop.

Auto Play

If this option is on (ticked), playback will start automatically as soon as a new file
selected from the dialog. If a new file is selected during playback, the previous
selection will stop and playback of the new selection will start directly.

You will not be able to play a file under the following conditions:
* If the file is in a format ReCycle doesn't support.
+ If there isn't enough memory (RAM) left to load the sample.

* If the sample is longer than 30 seconds, the Auto Play function will not work
- you can, however, audition it using Play.

File Type Selector (Windows only)

< When the last item on this menu is selected, the file list will show
all files in the directory that are in any of the formats that ReCycle
supports.

+

When any of the other alternatives are selected, the files list only
shows files in that format.

About The Different File Formats

ReCycle can load mono or stereo files that meet the following criteria:

* The bit depth can be 8, 16 or 24 bits.

* Sample rates between 11.025 kHz to 1.0 MHz are supported.

* The file is not longer than 5 minutes (regardless of sample rate and mono/
stereo status).

The table below shows the supported file formats.

Name Extension | Comment

ReCycle RX2/RCY/ REX2 (*.rx2) is the native file format created when
REX you save in ReCycle. RCY/REX are ReCycle files
that were created with previous versions of ReCy-
cle.
Wave WAV The standard Microsoft file format for audio. May be
stereo or mono or in formats other than 16-bits.
Audio IFF  AIF Audio Interchange File Format; Apple's standard

(AIFF) audio file format. May be stereo or mono or in for-
mats other than 16-bits.

In addition, the Macintosh version of ReCycle supports the following format:

Name Extension | Comment

Sound SD2 The current Digidesign file format. May
Designer Il be stereo or mono and at least 16 bits.
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Using Drag and Drop

ReCycle supports standard Drag and Drop. Proceed as follows:

1.

In the Finder/Explorer, locate an audio file in one of the supported
file formats.

Drag this file and drop it on the ReCycle icon.
If the program is already running, the file appears in a new window. If it isn't,
ReCycle launches and the file opens.

Launching from Files

EY

>

Any files created by ReCycle will open in ReCycle if you double click
on them.

In addition, (Windows only) you can open “WAV” or “AIF” files in
ReCycle by right-clicking on them in the Explorer, and selecting
“Edit with ReCycle” from the pop-up menu that appears.

If you chose to associate “WAV" or “AlF” file formats with ReCycle during
the installation, you can open these files in ReCycle by double clicking, just
as with ReCycle files.

Receiving Audio from the
Sampler

If you have an external sampler connected to the computer, ReCycle can receive
the audio directly from it.

1.

Make sure the sampler is selected on the lower half of the ReCycle
Sampler menu.

If the sampler cannot be found on the Sampler menu, you need to go into the
Sampler Settings dialog and add the sampler, as described on page 30.

Select “Receive...” from the Sampler menu.
A dialog appears. Its exact appearance depends on which sampler you have.

= Receive from My A3000 via MIDI+SCS | =

Sample: [wave

Cancel Receive

The Yamaha A3000 Receive dialog.

il

In the dialog box you will find a pop-up which allows you to select a
sample in the sampler.

Clicking Receive transfers the sample into the computer and opens
it in a new window.
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If the “Do you want to
move the left locator...”
dialog appears

If you Open or Receive a sample, and there is no loop setting, or the loop start is
just at the beginning of the sample, a dialog appears suggesting you should let
the program move the Left Locator to the first slice point. This is to avoid very
short slices at the beginning of the sample. We recommend that you click “Yes”
unless you have good reason.

< If you want this to be done automatically, open the Preferences di-
alog on the Edit menu and activate the option “Always Move Left
Locator to First Slice Point”.

When this is activated, ReCycle will automatically place the Left Locator on
the first slice point when you Open or Receive a sample, without asking.

See page 59 for more information on setting Locators.
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Window Overview Waveform Display

Slice Marker Handle Thumbnail overview Vertical Magpnification
Tool Bar O Demo.b.ail* —niee—e—e—e——o0p]
The left half of the Toolbar contains the following items:
Open/Save Effect buttons Stop  Slice Audition buttons
Transmit as one Sample Preview toggle Play a

= [l =ze] [EEE] [F[=]e 9] z]e] e
| S ns: —% 0 | Gate Sens Qﬂff

Tools Export Sound  Sensitivity slider Gate
Sensitivity

Transmit/Receive Silence Selected

The right half of the Toolbar contains the following items: : —

I 1
Length sclettings Time Signature Left Locator Slice Marker

Right Locator

Horizontal Magnification Waveform Level meter

Bars: | 1 + Beats: |0 | % I Sign: | 44 | & I Orig. Tempa: 840903 BEPM
| 0ff | Fitch @D.DD | Gain @u.uds | Tempo Q |94_|]|]|} BRI
| | —

Preview Pitch Processing Gain Preview Tempo setting
and Original Tempo
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Status Bar

The Status Bar is located at the bottom of the screen (MacOS) or at the bottom
of the application window (Win).

The leftmost area of the Status Bar displays the following:
< If you point anywhere on the Toolbar, this area will display “ex-
tended” tooltips and, if applicable, keyboard shortcuts in parenthe-

ses for any Toolbar item you point to.
This area says “Ready” if you are not pointing at any item.

Changes number of visible slices (+, -, 0-9)

Left corner of the Status Bar (while pointing at the Sensitivity Slider).

-+ Pointing in the waveform display will show the position (in seconds
or samples depending on the Preferences setting).

In addition, the Status Bar always displays the following properties regarding the
currently selected file in the right half of the Status Bar:

¢ Stereo/Mono status of the file.

¢ The sample rate at which the file was recorded.

* The number of slices between the locators.

* The length of the file in seconds.

¢ The size of the transmitted/exported data in bytes.

| stereo,44.1kHz | 13Slices,8.35s / 719 kB

Right corner of the Status Bar.

Window Title

DTO1.AIF =

The window title displays two things:

¢ The name of the file.
* An asterisk that indicates if the file hasn't been saved yet.

Toolbox

The Toolbox is located in the upper left corner of the toolbar. You select a tool
from the Toolbox by clicking on its icon. Below follows a brief description of
what the tools do. Detailed applications follow later in this chapter and in the fol-
lowing chapters.

Tool Description

Arrow Used for selecting Slice markers by clicking on their handles.
Hide Used for deactivating slices by clicking on their handles.
Lock Used for locking slices, by clicking on their handles.

Pencil This is used for adding slices manually.

Level Meter

Clip indicators

The level meter indicates the output level of the selected file during playback.

Two meter bars are shown for stereo files and one bar for mono files.

You should check that levels never cause the Clip indicator(s) at the top of the

meter to light up.

* If Preview mode is selected, the meters indicate the level post any applied
effects.

*  You can boost or cut the level with the “Gain” parameter in Preview mode.

In case of boosting the output level, watch the meter (and listen) carefully to

avoid clipping.
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Handling Windows

You can Open or Receive as many loops as RAM permits, and they will each ap-

pear in a window.

*  For more information about window handling, see the documentation that
came with your computer.

* ReCycle's Windows menu contains a list of the currently open windows. Se-

lecting one makes it active.
¢ The Close item on the File menu closes the active window.
¢ Close All on the Windows menu closes all windows.

Magnification, Song
Position and Scrolling
The Horizontal Magnification Indicator

N

If you click or drag in the horizontal magnification indicator, the amount of hori-
zontal zoom changes. Furthermore, the indicator will always show the current
magpnification.

The Vertical Magnification Indicator

If you click or drag in the vertical magnification indicator, the amount of vertical
zoom changes. The vertical scale is displayed in decibel, and the zoom factor
changes in steps of 6 dB. Minimum zoom will show 0 dB as the top and bottom
waveform amplitude boundaries in the window, the next factor will show -6, and
so on.

Using The Magnifying Glass

Zooming in
1. Hold down [Command] (MacOS) / [Control] (Windows).

2. Move the mouse over the waveform area.
The pointer turns into a magnifying glass.

+ Click once in the waveform.
The view is zoomed in one step. The position you clicked at will be centred in
the window.

Zooming out

< Zooming out is done the same way as zooming in, except you also
hold down the [Option] (MacOS) / [Alt] (Windows) key.

SR

The Zoom in and zoom out tools.

Using a Zoom rectangle

To select a certain area to zoom in on, proceed as follows:
1. Hold down [Command] (MacOS) / [Control] (Windows) and press
and hold the mouse button in the waveform display.

2. Drag to make up a selection rectangle.
The area inside the rectangle becomes dark.

3. Release the mouse button.
The selected area will now fill the entire window.

Zooming in on a certain area.

&b ReCucle!
THE RECYCLE WINDOW




Magnifying using the Thumbnail Overview

< The method of making up a rectangle with the [Command] key (Ma-
cOS) / [Control] key (Windows), described above, can also be used
in the thumbnail overview.
This changes the zoom factor of the main waveform, not of the thumbnail it-
self.

Zooming in using the thumbnail.

Scrolling using the Thumbnail

When zoomed in on the waveform, the Thumbnail Overview will display a dark
rectangular area indicating which part of the waveform is now shown in the main
waveform display. This rectangle can be dragged sideways, which scrolls the
waveform display. You can also click anywhere in the Thumbnail Overview to
move the rectangle to that position.

= ¢ =

Dragging the Thumbnail rectangle.

The Scroll Bar

The scroll bar can be used to scroll the view of the waveform.

Waveform Display
Options

You can customize the look of the Waveform window by using the settings at
the bottom of the Preferences dialog:

Waveform
[ View Stereo Files as Sum of L+R

Look: Shaded 4
il

[ Set Waveform Color... ]

Contrast: :

The “View stereo files as sum of L+R” Option

To make the size of stereo files in the ReCycle window more compact, the left
and right channels of stereo files can be summed to one channel, instead of be-
ing stacked on top of each other. Note that this is a display option only, the ac-
tual audio material is not affected in any way.

Waveform Look

Use this pop-up menu to select one of three different waveform "looks"; Plain,
3D or Shaded. Plain displays the waveform with normal graphics, 3D adds a
depth effect to the graphics and Shaded adds a progressive shade to the lower
part of the waveform.

Waveform Color

Click this button to select a new color for the waveform. On the Macintosh, this
brings up the standard Apple Color Picker, under Windows this brings up the
standard Windows Color dialog. The color field to the right shows you the cur-
rent color selection.

Contrast Slider

This slider sets the amount of contrast between the background display and the
waveform. For maximum contrast, position the slider all the way to the right. Mov-
ing the slider to the left progressively adds more of the chosen waveform color

to the background display.
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The View Menu

The View menu features the following items that relate to how the waveform is
displayed:

Magnify to Fit/Magnify to fit Loop

If you select Magnify to Fit from the View menu, the display will zoom out so that
the entire sample fits the window. If Magnify to Fit Loop is selected, the display
will zoom in (or out) so that the area between the left and right locators will fit the
window.

Jump to Cursor

If this is selected, the window will scroll to the current play position, maintaining
the current magnification factor.

Show Grid

You must have set a loop length for this item to be available. When enabled, a
grid showing Bars/Beats/16th notes is shown in the display.

Scroll during Playback

When you play back, the current position is indicated by a dotted line travelling
across the waveform. If the option "Scroll during Playback" is checked on the
View menu, the current position will always be displayed in the waveform dis-
play. This option can also be toggled on or off by pressing [F] on your computer
keyboard. A rectangle in the thumbnail overview indicates which area of the
waveform is currently displayed in the waveform display.

==

The thumbnail overview shows you which part of the waveform is displayed.

The Edit Menu

The Edit menu features the following items:

*  You can use “Copy Loop” to copy the entire loop (i.e. all waveform data be-
tween the left and right locators) to the clipboard.

 If the clipboard contains data, this can be pasted into a new (automatically
created) document window by using the “Paste as New Document” menu
item.

* ‘“Delete” can be used to delete selected slice markers.

Select All and Invert Selection are explained on page 57.

Undo/Redo

You may be able to Undo your last action by selecting this menu item or by
pressing [Command] (MacOS)/[Ctrl] (Windows)-[Z] (the default key command
for Undo). The menu item also gives you a clue about what will be undone. For
example: If it says “Undo Delete Slice(s)” the last thing you did was deleting a
slice.

If you wish to “Undo the Undo”, this is possible since after an Undo, this menu
command changes to “Redo”.

The following actions can be undone:

*  Move slice

* Delete slice(s)

* Hide slice(s)

*  Lock slice(s)

* Insert slice (Pencil tool)

* Move left/right locator
(All of the above items are described in the chapter “Setting Slices and
Loops”)

» Convert to mono

* Normalize

*  Crop Loop

» Convert sample rate

* Re-Analyze

e Preset selection (effects)
(All of the above items are described in the chapter “Processing Audio”)

&b ReCucle!
THE RECYCLE WINDOW




Context Menu Iltems

Right-clicking (Windows) or [Ctrl]-clicking (MacOS) in different areas of the
waveform display will bring up context-sensitive menus. The context menus will
contain various items also found on the Edit and View menus, but there are
some additional items that are only available via context menus.

Main Waveform Display

=
—~
+
=
]
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The highlighted area indicates the main waveform area.

By right-clicking (Windows) or [Ctrl]-clicking (MacOS) in the main area of the
Waveform display brings up a context menu with the following items:

Menu Item Description

Copy Loop See “The Edit Menu” above.

Set Left Locator to This Slice ~ The Left Locator will be placed at the begin-

ning of the slice you clicked on.

Set Right Locator to This Slice The Right Locator will be placed at the end of
the slice you clicked on.

Set Loop Around This Slice The left and right locators will be placed at
the start and end of the slice you clicked on,

respectively.

Jump to Cursor See “The View Menu” above.

Magnify to Fit/Magnify to Fit See “The View Menu” above.

Loop

Magnify to Fit Slice This will zoom the display so that a single
slice (the slice you clicked on) will fit the win-

dow.

Slice Marker Strip
=

The highlighted area indicates the Marker strip area.

Right-clicking (Windows) or [Citrl]-clicking (MacOS) in the marker strip (but not
directly on a slice marker handle), brings up a context menu with the following
items:

Menu Item
Select All

Description

This will select all slices. See page 57.

Invert Selection See page 57.

Magnify to Fit/Magnify to Fit See “The View Menu” above.

Loop
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Slice Handles

Right-clicking (Windows) or [Ctrl]-clicking (MacOS) directly on a slice handle,
brings up a context menu with the following items:

Menu Item Description

Locked Toggles the “Locked” status on or off for the
slice handle you click on. See page 56.

Hidden Toggles the “Hidden” status on or off for the
slice handle you click on. See page 54.

Delete This will delete any selected slice(s). See
page 58.

Select All This will select all slices. See page 57.

Invert Selection See page 57.

Set Left Locator to This sets the left locator to the slice handle

This Slice you click on.

Set Right Locator to This sets the right locator to the slice handle

This Slice you click on.

Magnify to Fit/Magnify to Fit See “The View Menu” above.
Loop

Left/Right Locator Area

| | 1= Zs EXS |

The highlighted area indicates the Locator area.

By right-clicking (Windows) or [Ctrl]-clicking (MacOS) in the Locator Area, the
“Magnify to Fit/Magnify to Fit Loop” menu items are available.
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Audio Quality

ReCycle plays back audio directly from your computer, using the sound capabil-
ities of your specific computer (see the Installation chapters for more details).
When transferred to a sampler, the sound is reproduced with the highest possi-
ble fidelity by the sampler. This may or may not be better than your computer’s
sound capabilities, depending on your setup.

Playing the entire Loop

To play the entire loop, press [Enter] on the numeric keypad or click the Play but-
ton.

-

The Play Button

To stop playback, press [0] on the numeric keypad or click the Stop button.

The Stop Button

In addition, you can toggle between Play and Stop modes by pressing [Space].

Auditioning Slices

There are three methods you can use to audition Slices:

EY

Using the mouse

When you move the mouse over the waveform area, the pointer turns into a
speaker icon. When you click with the speaker tool on a Slice (a section of
waveform between two Slice markers), it plays back. Press [Space] to stop
(even if you don't, playback automatically stops at the end of the Slice). If
you click and drag left or right you can audition consecutive slices (dragging
to the left will not play slices “backwards”, it only reverses the order that the
slices are played back in).

The “hot-spot” (the part of the pointer that you aim with) is indi-
cated by a cross.

The “hot-spot”. —)+n:]

Using the Slice Audition buttons
The three Slice audition buttons are located to the right beside the Play and
Stop buttons. They have the following respective functionality:

Id

=y

G

Play previous Slice (and make it the current). By repeatedly clicking
this button, you can step through the Slices in reverse order and au-
dition each one.

Play current Slice.

Play Slice and move to next (making the next Slice the current). By
repeatedly clicking this button, you can step through the Slices from
left to right and audition each one.
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The current Slice is indicated in the ReCycle window by a dotted vertical Slice
marker.

vl =F vl vl

The current Slice _)E

—

< Using the numeric keypad
The keys [7], [8] and [9] on the numeric keypad has the same functionality
as the corresponding three Slice audition buttons. Pressing [7] plays the
previous Slice, pressing [8] plays the current Slice and pressing [9] plays
the (current) Slice and moves to the next.

Moving the Current Slice without Auditioning

You can also use the numeric keypad to move the current Slice without audition-

ing:
< Press [4] to move the current Slice to the previous Slice.
Press [6] to move the current Slice to the next Slice.

Press [1] or [2] to move the current Slice to the Left/Right Locator
respectively.

Preview mode

The Preview function lets you audition the loop exactly as it will sound when
transmitted to a sampler, or saved as a file. In Preview mode you can change the
pitch or tempo independently from each other, change the gain of the loop, add
processing and more. Note that all Preview settings will be applied to the result-
ing saved file or when transmitted to your sampler!

! To audition non-REX2 files in Preview mode, you have to first spec-
ify the loop length (in Bars and Beats) to calculate the tempo, cre-
ate a sufficient amount of slices, before enabling Preview mode.
How to specify loop length and how to set slices is explained in the
next chapter “Setting Slices and Loops”.

Preview Tutorial

! Preview processing features are more fully described in the chapter
“Processing Audio”.

To try out some of the Preview features, use the supplied “Tutorial.rx2" file. This
loop already has correct slice, length and tempo settings, so that you can use
Preview mode straight away. Proceed as follows:

1. Locate the file “Tutorial.rx2” inside the ReCycle folder, and open it.
The Original Tempo field displays the original tempo of the loop, that was
calculated in ReCycle before it was saved as a REX2 file. The Tempo field
displays the current tempo.

2. When the file is loaded, click the Preview button.
The button becomes dark, indicating Preview mode. The previously “greyed
out” parameter knobs on the Toolbar now become active.

N

The Preview Toggle button.

3. Start playback using the Play button.

< Try changing the tempo of the loop using the Tempo knob.
Hold down [Command] (Mac) / [Ctrl] (Win) and click the Tempo knob to re-
set the tempo back to the original.

< Try changing the pitch of the loop using the Pitch knob.
You can change the pitch up or down two octaves (+/- 24 semitones). Hold
down [Command] (Mac) / [Ctrl] (Win) and click the Tempo knob to reset the
pitch back to the original.
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Click the Envelope button, or select “Envelope” from the View
menu.

The Envelope panel appears below the main toolbar. Envelope allows you to
adjust three parameters; Attack, Decay and Stretch (see the chapter “Pro-
cessing Audio” for a full description of the Envelope parameters). This par-
ticular file was saved with non-default Attack and Decay parameter settings,
which means that the Envelope effect is already turned on. This is indicated
by the darkened and lit On/Off button (the leftmost button on the panel).

mttack ) 6ms  Decay () 485 | Streteh () 40 %

Turn the “Stretch” knob fully to the left (0%).

Now lower the tempo of the loop down to about 70 bpm and start
playback.

As you can hear, at this tempo the slices sound “chopped off”, with a dis-
cernible gap of silence between each slice.

While still in playback, gradually turn the Stretch knob clockwise
until it is set to about 45%.

Like magic, the tail (end) portion of each slice is lengthened so that the gaps
disappear. The Stretch function actually generates sound. It analyzes the ex-
isting tail of each slice, and then lengthens it. This feature is used if you wish
to lower the tempo of a loop.

There are two other effect processors which can be applied in Pre-
view mode, “Transient Shaper” (compressor) and “Equalizer”.
These are described in the “Processing Audio” chapter.

For all Preview settings, the principle “what you hear is what you
get” applies to the resulting saved or exported file or when trans-
mitted to your sampler!
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Using Sensitivity

Most of the time when working with ReCycle, you will want to cut your loop up

into slices. A slice is a section of the waveform, from one slice marker to the next.

vl vl vl vl vl =

A slice marker

A slice

When you load or receive a loop, ReCycle analyzes it to determine where slice
markers should appear (where the individual sounds in the loop are).

The Sensitivity slider is then used by you, to set the overall amount of slices. The
higher the sensitivity, the more slices you will get. And, the more slices you have,
the smaller entities ReCycle will cut the loop into, when you transmit it. For more
information, see page 59.

The number to the right of the slider represents the current position of the slider,
where 0 represents minimum sensitivity and 99 maximum sensitivity.

As described below, the quickest way to get a good selection of slices is to set
the sensitivity quite high, roughly between 70 - 80, and then use the Hide Tool to
deactivate any slices you don't need (see later in this chapter for details on the
Hide Tool).

Setting Sensitivity using the Keyboard

< You can type a number on the typewriter part of the keyboard, di-
rectly.
This can be used to quickly give the slider a rough setting. If you hit “1” it
gets set to “11", if you press “2" it gets set to “22" etc.

< You can use the [+] and [-] keys to “nudge” the slider up and down.

About Stereo and Mono

For stereo files, ReCycle analyzes both channels for slice points. In all respects,
the methods you can use and other considerations are the same regardless
whether the audio is in stereo or mono.

Slices always cut across both channels at the same position in the waveform,
they are not channel independent.

Using the Hide tool

You might run into situations where there are too many slices on the screen. You
could of course reduce the Sensitivity to get rid of the slice markers you don't
want, but then other slice markers could disappear too, and this might not be de-
sirable. What you need to do in a situation like this is to “Hide" an individual
slice, and this is just what the Hide Tool lets you do: When you select the Hide
Tool and click on a slice marker it gets diminished and its line disappears.

= h 4

Before and after Hiding a slice marker.
To try the effect of hiding, proceed as follows:
1. Click on two adjacent slices which play one sound each.

2. Hide the marker that divides the two slices.

3. Click again to audition.
You will hear that what was previously two slices is now one.

F h: 4 F
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Hiding several Slices at the same Time

If you have several slices selected (see below) they will all get hidden when you
click on one of them.

= i il ol

Clicking on one of the selected slices...

= . A 4 - =

... hides all of them.

Bringing back Hidden Slices

To “re-activate” a hidden Slice, simply click on it again with the Hide tool.

When do | use the Hide tool?

Use the Hide tool when you have a situation like the one below:

ol F W

This slice is probably not
wanted.

In the example above, the Sensitivity slider had to be set to a fairly high value to
get the number of slices you see. But raising Sensitivity led to one unwanted
slice, splitting a sound in two. Hiding is the solution.

vl b = vl

After Hiding the unwanted slice.

How do | find unwanted Slices?

Our most important tip is this: Always audition each slice to hear what they actu-
ally play. Try stepping through the loop with the “Play Slice and Move to Next”
button, and adjust the Slices until you hear them the way you want them.

Another good practice is to increase magnification slightly and scroll through the
slices to look for sounds that have been split unnecessarily.

For optimal results, combine the two techniques above.
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Using the Lock Tool

The Lock tool is essentially the opposite of the Hide tool. If you lock a slice, by
clicking on its marker with the Lock tool, it will stay even if you drag the Sensitiv-
ity slider all the way to zero.

= i T

If a slice is locked...

...it will stay even if you set Sensitivity to zero.

Locking several Slices at the same time

If you have several slices selected (see below) they will all get locked when you
click on one of them.

- k4 F ¥

Clicking on one of the selected slices... ...locks all of them.

Unlocking Slices

To unlock a locked Slice, simply click on it again with the Lock tool.

When do | use the Lock tool?

If you got a good set of slices by just using the Sensitivity slider, but discover
that in one or two places you hear two sounds when you click on a slice, then it
is time to bring out the Lock tool.

1. Find the place where you hear two sounds when auditioning.
2. Make a mental note of the current slider setting.

3. Set the sensitivity slider to a higher value to get a slice between the
two sounds.

4. Audition to make sure you got what you wanted.
Lock the new slice.

Drag the sensitivity slider to the original setting.
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Selecting Slice Markers

Slice markers need to be selected for some operations, like Silence Selected
(see page 71 and page 84), or when moving and deleting slices (see “Manual
Slice Handling” in this chapter):

# Selecting is done with the Arrow Tool.
You can have the Pencil Tool selected, but this automatically changes to the
Arrow tool if you point in the Marker strip.

< You can select one marker by clicking on its triangle symbol.

If you hold down [Shift], you can click on more markers to select
them. Clicking again with [Shift] pressed deselects a marker.

. I v Ll
Selected and unselected markers.

< You can make up a selection rectangle by pointing between slices
in the Marker strip, pressing the mouse button and dragging left or
right. When you release the mouse button, all the slices inside the
rectangle will get selected.

| | |.Hh | |L||||. | | |Ih | ||u||||
Making up a rectangle like this... ...selects these markers.

< You can use the Select All item on the Edit menu to select all mark-
ers.

< If you have a selection of markers, you can invert the selection by
using “Invert Selection”, also on the Edit menu.
After this operation, the markers that were previously selected are now de-
selected, and vice versa. This is mainly useful together with Silence Se-
lected, see page 71 and page 84.

i A 4 T F
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Before and after using “Invert Selection”

< To deselect all markers, click between two markers on the ruler.

Manual Slice Handling

It is possible to add new, to move, and to delete slice markers manually.

Before adding or moving slices manually, make absolutely sure the
slices found by the analyze algorithm don’t suffice. The program is
very good at finding slice points, and the points found by the pro-
gram often work better - for example for tempo changes - than the
ones that you can find manually.

Adding a new slice

1.

Identify the area where you need a slice, and zoom in very close on
it.
Select the Pencil Tool.

Move the pointer over the waveform display.

A vertical line moves across the waveform. This line indicates where the slice
will appear when you click. The line snaps to zero crossings in the waveform
(positions where the amplitude is close to zero), so manually added slices
won't introduce any clicks or pops. If the amplitude is zero for a period of
time, the line will move continuously over this area.

The vertical line snaps to zero crossings.

4. When you have found the correct position, click with the Pencil tool.

The slice appears.

The following rules apply to manually added slices:

Manually added slices are locked. They will therefore not disappear when
you lower Sensitivity.

If you unlock a manually added slice and drag the sensitivity slider down
lower than halfway (below 50), it will disappear, just as other slices.
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Adding a Slice at any position

EY

If you hold down [Option] (MacOS) / [Alt] (Windows), the snhap to
zero crossing is disabled and you can add a slice at any position.
We do not recommend that you do this unless you have very good reason,
since it can introduce clicks and pops in the sound during playback.

Moving a slice marker

You can move a slice marker manually, even if it is locked (hidden slice markers
cannot be moved).

1.
2.
S

Make sure the Arrow or Pencil Tool is selected.
Select the existing slice marker that you wish to move.

Place it in the proximity where you want to move it to by dragging
the slice marker.

As you drag, the vertical line of the slice marker is superimposed across the
waveform. This line indicates where the slice will be placed when you re-
lease the mouse button.

After having placed the slice marker in the general area where you
would like to move the slice to, zoom in on it very closely and move
the slice marker to where you want it.

The line snaps to zero crossings in the waveform (positions where the ampli-
tude is close to zero) exactly like when adding slices, so manually moved
slices won't introduce any clicks or pops. If the amplitude is zero for a period
of time, the line will move continuously over this area.

When you have found the correct position, release the mouse but-
ton.

Only one slice marker at a time can be moved.

Moving a slice marker to any position

S

If you hold down [Option] (MacOS) / [Alt] (Windows), the snap to
zero crossing is disabled and you can move a slice to any position.
We do not recommend that you do this unless you have very good reason,
since it can introduce clicks and pops in the sound during playback.

When do | add/move Slices manually?

As described above, we suggest you only add or move slices manually when the
program fails to find one at a position where you need it. In other words, you will
need to add/move a slice manually when you click on a slice and hear two
sounds, one after the other, even though the Sensitivity slider is set to 99.

Where do | place the Slice?

Zoom in far enough for the display to clearly show how the cursor jumps be-
tween zero crossings. Try to find the first position before the beginning of the
sound. This applies both when adding and moving slices.

Deleting Slices

It is possible to permanently delete slice markers. Note that unless you are
100% certain that you won't need a slice, especially in case of slices detected
by the slicing algorithm, it is generally better practice to hide it using the Hide
Tool.

< To delete one or more slice markers, select it/them and press
[Backspace] or [Delete], or select Delete from the Edit menu.

! Deleted slices that were originally “discovered” by the slicing algo-
rithm can be made to appear again by using Re-Analyze (see page
66).
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How many Slices do |
need?

Well, it depends...

If you plan to edit the loop a lot in your MIDI sequencer, you should try to get
one slice per sound in the loop, or in some situations (very busy sections for
example), one slice per eighth note or sixteenth note (to simplify editing in
the sequencer).

If you want to create a groove, you should try to get approximately one slice
per eighth note, sixteenth note or whatever the loop requires.

If your main reason for slicing the loop is to change the tempo and/or pitch,
you generally need as many slices as you can get, but never more than one
per individual sound in the loop. This is to retain the “integrity” of each sound
when played back from the sequencer.

Please remember that your ears are always the best judge. Careful
auditioning is vital for finding a good selection of slices.

Left and Right Locator -
Setting the Loop

By dragging
The left and right Locators can be dragged to set the Loop during playback.

>

If you have no slices at all (if the Sensitivity slider is all the way to
the left), the Locators can be positioned freely.

If there are any slices visible, the Locators snap to the lines.

If you want to position the Locators freely, even though you have
slices, hold down [Option] (MacOS) / [Alt] (Win) while dragging a
Locator.

By clicking

>

>

To set the Left Locator, hold down [Shift] and click on the ruler.

To set the Right Locator, instead hold down [Command] (MacOS) /
[Control] (Win) and click.

Normally, the positions snap to the closest slice point, but if you
also hold down [Option] (MacOS) / [Alt] (Win) when you click, you
can set the Locator at any point.

Use the Slices when setting Loop Points!

When trying to find a good loop point, use snap to slices if at all possible. If you
can't seem to get a good loop point that way, try raising the Sensitivity slider to
get more slices and try again.

When - and only when - you can't find a good loop point in this way, zoom in
and adjust the Loop positions with [Option] (MacOS) / [Alt] (Win) pressed.

What are the Locators used for?

The Locators are of course used to define the loop you get during playback. But
they also have other purposes:

ReCycle uses the Locator positions when calculating the original tempo of
the Loop.

When transmitting audio to the sampler, saving to file etc., only the part be-
tween the Locators is actually sent.

When you create MIDI files, only the section between the Locators is taken
into consideration, as with the saved audio above.
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Tempo, Time Signature,
Bars and Beats

Many of the operations in ReCycle require you to specify how long the loop be-

tween the Locators actually is, meter-wise. This information is then used to cal-
culate the tempo of the loop.

Time Signature

The Sign pop-up menu allows you to choose between a few of the more com-
mon Time Signatures. If none of them fit your purpose, you can still “assemble” a
correct Time Signature using the Bars and Beats settings, see below.

Bars and Beats

The Bars field and Beats pop-up are used to specify the length of the loop. Let's
explain this by example:

|Actual Loop Length |Set “Bars” to: | Set “Beats” to:
One bar 1 0
Two bars 2 0
Half a bar in 4/4 0 2
One and a half bar in 6/8 1 3

As stated above, you can use Bars and Beats to “create” some unusual Time
Signatures:

Actual Loop Length Time Signature | Bars Beats
Two bars in 7/4 4/4 3 2
One barin 9/8 6/8 1 3

Original Tempo

.z I Orig. Tempo: 99.955 EPM

When the Left and Right Locators are set, and the correct Time Signature and

loop Length (Bars and Beats) has been specified, this area will show the calcu-

lated original tempo of the loop.
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About the Effects

ReCycle features three effect processors, Envelope, Equalizer, and Transient
Shaper, that can be used to further manipulate audio loops.

2 All effects are applied globally, i.e. they will affect all slices equally
in a loop.

< To be able to apply the effects, Preview mode must be activated.
To activate Preview mode for a file you must first set up the left and right lo-
cators, specify the length and time signature of the loop and create a suffi-
cient number of slices (see the previous chapter). You could also load REX2
(ReCycle's native file format) files for further processing of course, in which
case these settings have already been made and you can apply effects in
Preview mode directly.

< The principle “what you hear is what you get” applies when you ap-
ply effects, like with all the other Preview mode functions.

Open the Effect Panels

= A green light is shown in the Effect button if the
corresponding effect is activated.

The three Effect buttons (from left to right); Envelope, Transient Shaper and
Equalizer.

The three Effects each have their own panel, containing the parameters. By
clicking on one of the effect buttons located to the left of the transport controls
on the Toolbar, the corresponding panel is shown below the toolbar. You can
also open the effect panels from the View menu.

< The top to bottom order of the Effect panels also reflects the inter-
nal signal path of the effects.
If all are activated, Envelope is always the first effect in the signal path, the
Transient Shaper is the second, and Equalizer is the last.
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The three effect panels.

e Cut \.) 20 kHz

Activating Effects

Effects can be active regardless of whether the panel is visible or not. There are
two ways you can activate effects:

< By clicking on the Effect On/Off button on an open panel.
When an effect is on (activated), the On/Off button becomes dark, and a
green light is shown in the effect button for the corresponding effect.

_ Effect On /O

Effect On/Off button.

< By holding down [Option] (Mac) / [Alt] (Win) and clicking on an ef-
fect button you can toggle the effect on and off.
About the Presets

For each Effect there are a number of preset settings available.

< To select a Preset, click on the Preset button beside the Effect On/
Off button.
A pop-up menu appears with the available Presets listed.

The Effect Presets button.

! Itis not possible to store user presets.

About the Parameter Controls
For all effect parameter controls, the following applies:

< [Shift]-clicking a parameter increases the resolution of the adjust-
able range.
Use this for a finer tuning range.

+ [Ctrl]-clicking (Win) / [Command]-clicking (Mac) a parameter resets
the parameter to the default value.
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Effect Parameters

Envelope

=
g || Attack Q 0 ms

Decay Q Infs

To open the Envelope processor, click on the Envelope button, or select Enve-
lope from the View menu.

Stretch Q 58 %

The Envelope Attack and Decay parameters govern how the volume of a slice
should change over time, from the time it is triggered (the slice note starts) until
the slice note ends. This can be used to make a loop more distinct (by having a
snappy attack and a short decay time) or more spaced-out (by raising the attack
time). Short attacks can also be used to mask out clicks that may occur with cer-
tain types of loops, when played back with a different tempo than the original.

The Envelope panel also features a third parameter; “Stretch”, which is de-
scribed separately below.

< The Attack parameter determines the attack length (in millisec-
onds) for each slice.
The higher the setting, the slower the attack. Parameter range is 0 - 0.5 s.

< The Decay parameter controls the length of the end portion (tail) of
each slice.
The more the knob is turned anti-clockwise, the shorter the decay. Range is
27ms - Infinite (=full decay).

Stretch

This feature is used when you know you might want to lower the tempo of the
loop in your MIDI sequencer.

How Stretch works

When you slice up a loop and play it back from your sequencer, each sample will
play in succession. At the original tempo, one slice will end exactly where an-
other starts.

As you understand, when you then lower the tempo, there will be small gaps be-
tween the slices, which disrupts the flow of the audio.

Stretch is used to add an extra tail of audio to each slice, to lengthen it. This is
derived from the natural decay of the sound. This extra tail of sound then fills out
the gap between the slices when the tempo is lowered.

! Please note that the attack of the sound is not affected in any way.

The Amount of Stretch

The Stretch knob is used to set the amount of stretch as a percentage value.

The percentage values tell you how much longer the entire sample will be after
stretching. If you select the largest value (100%), for example, the slice will be-
come twice its original length when transmitted to the samplerexported.

< To decide how much stretch you need, lower the Preview tempo by
the same amount as you intend to use, and adjust the Stretch pa-
rameter as necessary.
If there is a discernible gap of silence between slices you should raise the
Stretch setting.

! Note that Stretch is not Time Stretch! The Stretch feature doesn't
lengthen the whole slice, it only adds a portion of sound to the end
of it.

Stretch and the old REX Formats

You should be aware of the fact that REX (as opposed to REX2) files can con-
tain certain settings that are irreversible. For example, if stretch was applied
when the file was saved, the stretching is part of the actual REX file and cannot
be removed. It is possible, however, to apply more stretch, which may or may not
be what you want.

< For REX files it is therefore advisable to try lowering the tempo in
Preview mode first, to see if you actually need to apply Stretch.
REX2 files however, only contain the actual audio and the slices, the rest (ef-
fects, stretch setting etc.) is added when the file is loaded and can be
changed at any time.
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Transient Shaper
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Equalizer
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Transient Shaper parameters...
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...and the Gain meter.

The Transient Shaper is a type of attack/release envelope control, which pro-

duces a result that could be likened to compression. Compressors level out the

audio, by making loud sounds softer and vice versa. The result is that the levels
become more even and individual sounds can get more power and “punch”.

*  “Normal” compressors are activated by peaks and volume changes in the
actual audio. The Transient Shaper is instead activated by the individual
slices in the loop.

Regardless of method, if you have ever used a compressor, you will find that the

Transient Shaper will affect the sound in a similar way. It is, however, important

to be aware of this difference, as the Transient Shaper won't work as intended

unless the file contains slices!

To compensate for the volume loss that can be caused by this effect, the Tran-

sient Shaper has automatic gain compensation, that raises the overall level by a

suitable amount. The parameters are as follows:

I Parameter
Threshold

I Description

This is the threshold level above which the effect sets in. After
the initial slice attack, signals with levels above the threshold
will be affected, signals below it will not. In practice, this means
that the lower the Threshold setting, the more the signal will be
affected by the Transient Shaper. The range is -6 to -40 dB.

Amount This lets you specify the amount of gain reduction applied to

the signals above the set threshold. The range is 0 to 99.

Attack This governs how quickly the envelope will apply its effect
when signals rise above the set threshold. If you raise this
value, the response will be slower, allowing more of the signal
to pass through unaffected. Typically, this is used for preserv-

ing the attacks of the sounds. The range is 0 to 91 ms.

Release When the signal level drops below the set threshold, this de-
termines how long it takes before the Transient Shaper lets the
sound through unaffected. Set this to short values for intense,
“pumping” compressor effects, or to longer values for a

smoother change of the dynamics. The rangeis 13 msto 1.4 s.

This shows the amount of gain reduction or increase (in dB),
caused by the combined compression and gain compensation.

Gain meter

The main Equalizer parameters.

|LoCth15Hz | |HiCthZDkH2

Lo Cut and Hi Cut parameters.

The Equalizer allows you to cut or boost selected frequencies to shape the over-
all sound quality. To open the Equalizer panel, click on the Equalizer button or
select it on the View menu. The parameters are as follows:

Parameter Description

Lo Cut A highpass filter allowing you to set the lower limit
of the overall frequency range. You can progres-
sively cut frequencies from 15 Hz up to 12 kHz.

The center frequency for the low-end equalization.
Around this frequency, the sound will be boosted
or cut according to the Low Gain setting. The avail-
able frequency range is 20 Hz to 3 kHz.

Low Frequency

Low Gain Governs the amount of boost or cut around the set
frequency. The range is + 18dB.
Low Q Determines the width of the frequency band

around the center frequency to be affected. The
narrower frequency band, the more drastic effect
of the boost or cut. Range is 0.5 to 10.

High Frequency The center frequency for the high-end equalization.
Around this frequency, the sound will be boosted
or cut according to the High Gain setting. The

available frequency range is 1.5 kHz to 16 kHz.

Governs the amount of boost or cut around the set
frequency. The range is = 18dB.

High Gain

High Q Determines the width of the frequency band
around the center frequency to be affected. The
higher the Q setting is, the narrower the frequency
band will be, and this will cause a more drastic ef-

fect of the boost or cut. Range is 0.5 to 10.

Hi Cut A lowpass filter allowing you to set the upper limit
of the overall frequency range. You can progres-
sively cut frequencies from 20 kHz down to 100

Hz.
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The Process Menu

In addition to the three Effect processors, there are several other “offline” (non-
realtime) audio processing functions available on the Process menu. You do not
have to use Preview mode to apply offline processing. The Process menu items
are as follows:

*  Normalize

+ Convert to Mono

» Convert Sample Rate

*  Crop Loop
*  Remove DC
* Re-Analyze

All offline processing is undoable, but remember that if you do not
choose to undo, the processing becomes irreversible after the next
undoable action is performed. You will not permanently alter the
file until it is saved, however.

Normalize
Normalize will change the gain to ensure maximum level.

< When Normalize is selected on the Process menu, a dialog box ap-
pears asking if you want to Normalize the whole file or each slice.
Normally, you will select “Whole File". If you select “Each Slice”, and the se-
lected file is a rhythmic loop, the normalizing will disrupt the inherent dynam-
ics of the loop, since the gain of each slice will be changed to more or less
equal level.

< Normalizing each slice can be useful when you use ReCycle to pro-
cess individual sounds that don’t belong to a loop.

Normalize can’t do miracles. If your recording contains unwanted
noise, normalizing will increase the noise level together with the
other audio material.

Convert to Mono

This Process menu item will convert stereo files to mono. It is only selectable for
stereo files.

< When this item is selected, a dialog appears asking which chan-
nel(s) you wish to use as the basis for the converted file.
The options are Left, Right or a mix of both Left and Right channels.

Convert to Mono

Use Channel

) Left

() Right

@ Mix Left+Right

i

Convert Sample Rate

This item allows you to convert the sample rate of a file. Lowering the sample
rate will make the samples occupy less memory in the sampler and will make
files smaller, but it will also lower the fidelity of the recording (less high fre-
quency material will be present).

On the other hand, increasing the sample rate will not raise the fidelity of the
sample in any way. It is therefore not recommended to convert from a low rate to
a higher one, unless it is required by the application.

Selecting this menu item brings up a dialog box. This shows the file's current
sample rate, and the sample rates you can convert to.

Convert Sample Rate

Sample Rate

{3 11025Hz @ 44100 Hz
{3 22050Hz (3 48000 Hz
{3 32000Hz (3 96000 Hz

Current: 44100 Hz

Comer) ()
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Crop Loop

+ Crop Loop allows you to trim files, by removing all audio data out-
side the left and right locators.
If you have set up a perfect loop with the locators, and the file contains audio
outside this locator range you can use Crop Loop to remove this superfluous
data.

Remove DC

This function will remove any DC offset in the audio. DC offset is when there is
too large a DC (direct current) component in the signal, sometimes visible as the
signal not being visually centered around the “zero level axis”. DC offset can in-
troduce clicks if the slices are later moved around in a sequencer, and it also af-
fects zero crossing detection (see page 57) and certain processing functions
such as Re-Analyze and Normalize.

Re-Analyze

Re-Analyze re-runs the slice-detection algorithm on the waveform data. You may
have deleted slices that were detected when the file was first sliced. This com-
mand will "re-discover” those slices.

< Re-Analyze will add all slices that lies on a position in the file not
already occupied by a slice.
Note that the added slices may not be visible, as this depends on the Sensi-
tivity setting!

Additional Processing
ltems

There are a number of additional real-time processing items available on the
Toolbar (Preview mode must be activated):

Processing Gain

Gain Qo.o 4B

This function allows you to change the gain (volume) of the loop. The applied
gain change will be present when the loop is saved/transmitted/exported.

The main use of this function is to compensate for possible clipping or level
changes introduced by other processing items, like equalization for example.

< You can boost the gain by up to 18 dB, or lower it down to silence
(-80 dB).
You should avoid boosting the signal to the extent that the Level Meter clip
indicators light up often. If they momentarily light up once, you should listen
carefully to see if it sounds o.k (a slight amount of clipping on percussive ma-
terial is not necessarily even noticeable). The final judge should always be
your ears!
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Gate Sensitivity

Gate Sens () Off

Gate Sensitivity could be described as a type of noise gate. It is triggered
(opened) by every active slice start, and closes for any material (in each slice)
that falls below a set threshold. When you set the Gate Sensitivity so that the
end part of the slice(s) fall below the threshold, the gated part of the waveform
will be greyed out. The “gated out” material is not transmitted or exported.

This function has three primary uses:

< It can be used to remove part of a file that contains silence, for ex-
ample in conjunction with Silence Selected (see page 71).
By removing “silent data”, the size of the transmitted/exported data is re-
duced.

< It can be used if you have a file with several individual sounds con-
taining “air” in between the sounds, and want to save each one as a
separate file.
Used together with the slice algorithm, this also keeps the size of the trans-
mitted/exported data down, and saves you from having to trim the files in
your sampler.

< It can be used for special effects - abruptly chopping off a reverb
tail for example.

Preview Pitch

pitch (7) 0.00

You can change the pitch of a loop up or down two octaves (+/- 24 semitones).
Hold down [Command] (Mac) / [Ctrl] (Win) and click the Pitch knob to reset the

pitch back to original. Hold down [Shift] for adjusting values in finer increments.

Preview Tempo

Tempo Q EPM

You can change the tempo of the loop. Tempo values between 20 to 450 BPM
can be set using the Tempo knob or by typing directly in the Tempo box and
pressing [Enter].

Hold down [Command] (Mac) / [Ctrl] (Win) and click the Tempo knob to reset

the tempo back to the original. Hold down [Shift] for adjusting values in finer in-

crements.
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Selecting a Sampler to
Transmit to

To route the Receive and Transmit functions to a particular sampler, select it
from lower section of the Sampler menu. If your sampler is not on the menu you
must add it in the Sampler Settings dialog, see page 30.

! Forfile-based samplers such as SampleCell and for the Akai
S$5000/6000 sampler series you do not use the Transmit dialog, but
the Export dialog on the File menu. See the Sampler and File Refer-
ence pdf manual for details.

hy A3000 via MIDI+SCS]
+ My 53000 via 5051

An Akai S3000 selected.

You can have several samplers connected, either of different types or of the
same type, but only one at a time can be selected.

You can switch samplers while you are working with the program, which allows
you for example to Receive a sound from one sampler and Transmit it to another.

Transmit and Memory

The program needs free memory in the computer for Transmitting. In a worst
case scenario (with Stretch set to 100%) it needs twice the memory of the long-
est slice. This means that if you have “Transmit As One Sample” turned on and
use high Stretch factors, you need to make sure you have enough memory left
when you Transmit.

For more information, see page 14 (MacOS only) and page 36.

Transmit Options

On the Process menu, you will find two Transmit settings (or “options”); "Trans-
mit as One Sample” and “Silence Selected”. These options can also be toggled
on or off using the two Transmit Option buttons on the Toolbar:

Transmit as One Sample Silence Selected
— =

< Transmit as One Sample has no effect on playback in ReCycle. Si-
lence Selected, however, can be auditioned in Preview mode.

< Each document has its own settings.
If you are working with a lot of windows, be sure to check that the settings
are correct before you Transmit. The settings are also saved to disk with the
file when you Save.

Transmit as One Sample

Deactivated

When Transmit As One Sample is turned off, the audio gets sliced into individ-
ual samples when transmitted, and the MIDI files created will contain one note
for each of those slices.

! This is the preferred mode if you want to use your MIDI sequencer
to edit the loop, change its tempo or use the MIDI file as a groove.

Activated

When Transmit As One Sample is turned on, the program will transmit the part
that stretches from the Left Locator to the Right as one sample. Also, in this
mode, the MIDI File will only consist of one event, with the length set using the
Bars and Beats settings.

When should Transmit as one Sample be Activated?

One obvious application of transmitting as one sample (as opposed to separate
slices) is when you simply want to change the properties (like pitch and/or
tempo) of an audio file without otherwise changing it. Say you have an audio file
(Wave, Aiff etc.) that you wish to use in a song. The problem is that the tempo
and/or the pitch of the file is wrong for the song, and you wish to fix this. The so-
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lution is to open the file in ReCycle, then slice it up and set the length of the loop
using the normal techniques. Enter Preview mode, set the new tempo and/or

pitch, and lastly export the file in it's original format but with a new tempo and/or
pitch etc. A step by step example of exporting to file can be found on page 28.

Transmit as One Sample can also be used in conjunction with Silence Selected
to separate sounds from a loop (see below and on page 84).

Silence Selected

When this function is activated, the slices that have selected markers will be si-
lenced when transmitted or exported. Preview mode has to be activated for Si-
lence Selected to be available.

i i et

R A A A A A

s

..will be replaced by silence.

This feature is probably best used when Transmit As One Sample is turned on,
to silence individual sounds in a longer sample. An application of this is found on
page 84. It can also be used to simply skip unwanted sounds, when slicing.

But, Silence Selected works even if Transmit As One Sample is turned off. In
this case, the selected slices will simply be skipped, both when transmitting to
the sampler and when creating MIDI Files. You can use the Gate Sensitivity pa-
rameter (see page 67) in combination with this feature to remove the silenced
portions of the loop.

The Transmit dialog

The top menu item on the Sampler menu changes name depending on which
sampler you have selected (“Transmit to...").

! For other formats (see the online Sampler and File Format Refer-
ence document) for which the program saves audio files on your
computer’s hard disk, you do not use the Sampler menu. You in-
stead use the Export dialog on the File menu (see page 76).

There are three ways you can execute Transmit:

< By clicking the Transmit button.

)

The Transmit button.

By pressing [Command]+[T] (MacOS) or [Ctri]+[T] (Windows).

+ By selecting “Transmit to...” from the Sampler menu.

Sampler
Transmit to My, 53000 via 5C51
Receive from My 53000 via SCSI1

v My 53000 via SCSI
The Sampler menu when an Akai S3000 is selected.

38/T
3R

Transmit to My A3000 via MIDI+SCS1

Sample Bank Name: IDrum Tools Demd I
Sample Rate: [ 44.1kHz i]
Template: [ [Default] i]

Cancel I Transmitl MIDI File + Transmit... II

The A3000 Transmit dialog.

Exactly how the dialog looks depends on the selected Sampler, but there are a
few standard items you will most often find there:
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Program Name

Using this field you can specify a name for the Programs you are about to create
in the sampler.

*  You can specify the name directly in the dialog. You will only be able to type
in characters supported by the sampler, and the name will be truncated to fit
the length of the names in the specific sampler.

¢ The actual slices that the Program contains will get names derived from the
Program name, with a number added at the end. For example BigDrums#01,
BigDrums#02, etc.

Sample rate

ReCycle can handle samples with any sample rate and can convert samples
from any rate to any other.

Status Bar shows inherent rate

When you Open or Receive a sample, its inherent sample rate is displayed in the
Status Bar at the bottom of the ReCycle application window (Windows) or at
the bottom of the screen (MacOS).

[ Mono,44.1kHz |

A sample recorded at 44.1 kHz.

Available rates

In the transmit dialog, a number of sample rates can be selected from a pop-up.
Exactly what options are available depends on the selected sampler.

< |If possible, the sample’s inherent rate is suggested.
If, for example, the sample was recorded at 48 kHz, this will be the suggested
sample rate in the Transmit dialog.

< If the sample’s inherent rate is not supported by the sampler, the
next higher rate is suggested.

< In addition to the above, a number of other sample rates can be se-
lected from the pop-up in the Transmit dialog.
If the sampler only handles a few sample rates, they can all be selected. If
the sampler supports many rates, the most commonly used ones (or the
ones closest to these) are available. Those most common rates are 11.025
kHz, 22.05 kHz, 32 kHz, 44.1 kHz and 48 kHz.

When is sample rate conversion performed?

If you transmit, and the sample rate set in the Transmit dialog is not the same as
shown on the Status Bar (the sample’s inherent rate), a sample rate conversion
will be performed during the transmission.

When should | change from the suggested sample rate?

Lowering the sample rate will make the samples occupy less memory in the sam-
pler, but it will also lower the fidelity of the recording (less high frequency mate-
rial will be present).

On the other hand, increasing the sample rate will not raise the fidelity of the
sample in any way. It is therefore not recommended to convert from a low rate to
a higher one, unless it is required by the sampler.

! You can also convert sample rate using offline processing (see
page 65).

Templates

When ReCycle sends audio to your sampler it will put the samples it creates in
a “container” which holds all the samples and their mapping on the keyboard.
This “container” may be called a Program, Instrument, Patch or similar, all de-
pendent on the naming used by the sampler manufacturer. For now, let’s call it a
Program.

There are a number of settings in the Program which may or may not be of im-
portance to you.

*  If the settings are not important to you, you don't need to use templates, you
should use the Default option in the Transmit dialog. ReCycle will then cre-
ate as simple a Program as possible. You can then change this Program’s
settings by using the controls on the sampler itself.

* If you do need special settings, you use Templates. You might for example
want the first slice to appear on a certain key, you might want to have all
samples play to a certain output, you may want the Program to receive on a
certain MIDI Channel etc. Proceed as follows:

1. On the sampler, manually create a Program with the desired set-
tings.

Make sure the first sample in the Program’s keyboard map is positioned
where you want the first sample in the keyboard map created by ReCycle.

2. Save this Program to disk (using the sampler’s regular file saving
functions), for later use, but make sure it still resides in the sam-
pler’s internal memory.

3. Inthe ReCycle Transmit dialog, select this program on the Template
pop-up.
Exactly how this is done depends on the sampler. If it is external you can se-
lect the Program from a pop-up menu in the dialog. If ReCycle saves the
data on to your computer’s hard disk, then you select a disk file as your tem-
plate.
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4. Transmit/Export the Program.
A new Program is created in the sampler. It will get all the settings of the
Template. The first slice will appear on the same key as where the first sam-
ple in the Template was.

If you use exactly the same name as the Template, the new Program
may replace the Template.

Transmit

This button creates a Program and samples for it as described above, without
creating any MIDI File.

MIDI File + Transmit
This button will make two things happen:
< Programs and samples are created as described above.

+ Afile dialog appears, which allows you to create a MIDI File on your
computer’s disk.

This resulting file should be used in your sequencer, to play the loop in the sam-
pler.
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Saving ReCycle
Documents

If you have opened an audio file and worked on the slices and other settings, you
can save it as a ReCycle (REX2) document.

< Saving is done using the regular “Save” and “Save As” commands.

+ ReCycle files can be opened just like regular audio files (see page
36).
One difference is that no analysis needs to be performed, since the analysis
data is already included in the file.

< ReCycle files have the extension “.rx2”.
The ReCycle document will include all settings made in Preview
mode as well as the actual audio data.

These include:

* Al the slice points and their status (locked, hidden etc.).

* All real-time processing features, like tempo, pitch settings, Stretch amount
etc.

* Any applied offline processing like Normalize etc.

Exporting Files

The Export Sound dialog is opened by selecting “Export..." on the File menu, or
by clicking the Export Sound button.

T Export sound

Export Sound: ReCycle

[ &) REXFiles B

NN

ﬁ Abstract HipHop 2/22/:/0

ﬁ Chemical Beats 10411400 =

G prum N Bsss 12/18/00

j oub 10/11/00

§ Erectronic 10/11/00 E

(5§ Hardeore 1o/11/00 |2

- ~
Name: Il]l.aif I [ New [ ]
Type: [ Audio IFF B

[4 Add Extension to File Name
[ Cancel ] H Save ]l

A

The Export Sound is similar to the normal Save dialog, but contains a few extra
items. The Export dialog is used if you want to save your files for internal sam-
plers and other formats (see the online Sampler and File Format References
document) for which the program saves audio files on your computer’s hard
disk.

It can also be used to change the inherent properties of a sound file. You could
for example load a Wave file, change the file's tempo and export it as a new
Wave file.
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File Formats

The File Format pop-up is where you select the file format you wish to export the
file as. The following file formats are supported:

Name Ext. Comment

Standard MIDI File ~ MID Allows you to export a MIDI file (see page

78 for details).

Wave WAV The standard Microsoft file format for audio.
Exports one or several files, with one slice in
each file, depending on the “Transmit as
One Sample” setting on the Process menu.

Audio IFF AlF Audio Interchange File Format; Apple's

(AIFF) standard audio file format. Exports one or
several files, with one slice in each file, de-
pending on the “Transmit as One Sample”
setting on the Process menu.

Sound Designer Il SD2
(MacOS only)

The current Digidesign file format. Exports
one or several files, with one slice in each
file, depending on the “Transmit as One
Sample” setting on the Process menu.

Mixman TRK (for “Track”) files are the build-
ing blocks in the Mixman Studio and Mix-
man Studio Pro applications. To facilitate
tempo-matching, the Mixman TRK files con-
tain “slices” internally (somewhat like ReCy-
cle files). A single file is created. If the
exported document is a stereo file, an alert
box will appear informing you that the out-
put will be mixed to mono, since Mixman
files are always mono. See the Sampler and
File Format Reference documentation for
details.

Mixman Track File TRK

Sample Cell Instru-  INS
ment File

Digidesign’s SampleCell is a PCl based
sampler card/software editor for both the
MacOS and Windows platforms. ReCycle
exports an Instrument file plus one or sev-
eral sound files, with one slice in each file,
depending on the “Transmit as One Sam-
ple” setting on the Process menu. ReCy-
cle's Export settings for Sample Cell
supports templates, see page 72. Creates
AIFF or SD Il files (MacOS) or Wave files
(Windows). See the Sampler and File For-
mat Reference documentation for details.

Name Ext.

SoundFont 2 SF2 SoundFont is a file format for storing wavet-

Banks able synthesized sounds. Effectively, this
turns an ordinary sound card into a sampler.
Creates a single file when exported. See
the Sampler and File Format Reference
documentation for details.

Comment

Akai S5000/S6000 AKP
Program Files

Exports a program file together with one or
several Wave files, with one slice in each
file, depending on the “Transmit as One
Sample” setting on the Process menu. AKP
files are program files for the Akai S5000/
S6000 series of samplers. See the Sampler
and File Format Reference documentation
for details.
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Export Settings

Export Settings

. P
.| B SovinudFanl !‘r

Export MIDI File with Same Name

[ Cancel ] [ Export ]l

Sample Rate:

Before exporting a file in one of the supported formats, the Export Settings dia-
log is shown. The following items may be present, depending on the selected
export format:

< A Sample Rate pop-up allows you to change the sample rate when

Exporting.
Supported sample rates depend on the File Format selected.
An “Export MIDI File with Same Name” tickbox.

When checked, a MIDI file with the specified name, plus the extension
".MID" will be generated together with the exported file.

The above options are not available for Standard MIDI files or Mix-
man TRK files. Also, the SampleCell format has additional options
(see table).

Using REX2 files in Cubase VST

To ReCycle a file for use in Steinberg Cubase VST (version 5.0 or later) or other
programs capable of reading REX2 files, proceed as follows:

This text describes how to use REX2 files with Cubase VST. If you
are using another REX2-compatible program, see its documenta-
tion for details.

Locate the file on disk and open it in ReCycle.
This can be a file recorded in Cubase, or a file of any other origin.

Set up the slices, length, time signature, and use Preview mode to
apply effects or change tempo or pitch, as desired.

Remember that “what you hear is what you get” in the resulting REX2 file
when using Preview mode.

Make sure “Transmit as One Sample” is deactivated on the Process
menu.

4. Select “Save”, from the File menu.

5. Specify a location and name for the file and save it.

6. Switch over to Cubase VST.

You need version 5 or later (same for both the Mac and Windows platforms)
to be able to import REX2 files.

Select an Audio Track where you want to import the file and set the
Left Locator at the position where you want the file to appear.
Depending on the type and complexity of the audio, you may want to set the
Audio Track to channel “Any”. See the Cubase VST documentation for de-
tails.

Select “Import ReCycle file”, from the File menu.

Locate the ReCycle export file you just saved, and open it.

Now the following happens:

The file is added to the Pool.

A number of Segments are created for the file, each one corresponding to a
slice in Recycle.

A Part which will play these Segments is automatically created on the active
Track, starting at the Left Locator position.

Now you can play back the ReCycled file in any tempo, as if using a sampler.
You can also edit it in detail, quantize, etc.

If you need to re-import the file into the Arrangement, drag the file
item from the Pool to the Arrangement, just as any other file.
A new Part is then created.

There are a number of additional factors to be aware of when using
REX2 files in Cubase VST. See the Cubase manual for details!

Exporting MIDI Files

There are threet ways to create MIDI Files with ReCycle:

Y

By selecting MIDI file+Transmit in the Transmit dialog.

By selecting Export from the File menu and then selecting “Stan-
dard MIDI File” as the File Format in the dialog.
This is used if you wish to create a groove template.

By selecting Export from the File menu and then ticking the “Export
MIDI File with Same Name” option in the Export Settings dialog.
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Normally you will create MIDI Files as a part of the transmission process (by
clicking “MIDI File+Transmit” in the Transmit dialog). But if you only want to cre-
ate a MIDI File (for example when using ReCycle to create “groove maps”), use
the Export dialog and save as a Standard MIDI File.

In either case you are prompted with a regular File dialog where you can specify
a name and location for the file.

ReCycle always creates MIDI Files of type 1. However, they only contain one
Track plus a Tempo Track.

Templates and MIDI Files

* If you create a MIDI File from the Transmit dialog, the position of the first
sample in the Template affects the transposition of the MIDI File (so that the
file plays the right samples).

* If you use “Export Standard MIDI File" the first note is always C1.

“Transmit As One Sample” and MIDI Files

* If Transmit As One Sample is turned off, the MIDI File will contain a number
of short events, each triggering a slice in the sampler, to recreate the loop.
This is the mode to use if you want to create a “groove map”.

* If Transmit As One Sample is turned on, there will only be one long event
which triggers the entire sample.

“Silence Selected” and MIDI Files

Silence Selected only affects the MIDI File if Transmit As One Sample is turned
off, as described on page 71.
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Which Samples will work?

All. But although ReCycle does a very intelligent analysis of the sample to find

the individual “hits” or “sounds” in it, the sample has to meet some basic criteria

to enable the automatic algorithm to find all the individual sounds:

* Each sound in the sample must have some kind of perceivable attack. You
will for example run into problems with legato playing on a flute.

* The sample must be adequately recorded. Weak sounds recorded at very
low volumes might not get all the slices they should.

* The program might have problems with sounds drowned in smearing ef-
fects, like extremely thick chorus or short repeating delays.

Please remember that you always have the possibility to add slices “manually”.
Using Normalize and Re-Analyze to increase
“readability”

If you have a loop that was very poorly recorded, you might be able to get a bet-
ter recognition by normalizing it and then applying Re-Analyze (see page 66).

! You should first check if the file contains DC offset (see page 66)
and if so, remove it. The presence of DC offset can negatively affect
both the Normalize function and Re-Analyze.

1. Select “Normalize” from the Process menu.
A dialog appears asking if you would like to process the whole file or each
slice (see page 65).

2. Select “Whole File”
The file is now normalized.

3. Select Re-Analyze from the Process menu.

Raise Sensitivity to check if the recognition got better.

! All offline processing is undoable (last action undo). However, use
“Save As” to save a copy if you do not want to risk altering the orig-
inal file.

The Simple Trim

The most basic thing you can do with ReCycle is to set a good loop point for a
sample and then transmit it to the Sampler, or export it as a file, without any slic-
ing or processing.

1.
2.
3.

Open or Receive the sample.
Raise the Sensitivity until a large number of slices appear.

Activate playback and move the loop points until you find a good
loop.

Make sure the loops starts on a downbeat (sometimes you might
decide to let the loop start somewhere else but we just want to
make sure this doesn’t happen by accident).

Set the Time Signature and length (Bars/Beats) to whatever the
length of the loop.
The Tempo gets calculated.

Make sure “Transmit as One Sample” is selected (ticked) on the
Process menu, and that Stretch is set to 0%!

Select your sampler from the Sampler menu and select Transmit or
MIDI File+Transmit, or simply export the file in the format of your
choice.

The MIDI File you get will contain one event which plays the entire loop at
the calculated tempo.

Load the MIDI File into your sequencer and set things up so that it
plays the correct “Program” in your sampler (optional).

Repeat the MIDI File in your sequencer, as needed (optional).
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Slicing for Tempo
Changes - Sampler and
REX

1.

Open or Receive the sample.
Raise the Sensitivity Slider until a lot of slices appear.

Activate playback and move the loop points until you find a good
loop.

Work on the slices with the Hide and Lock tools until you have one
slice per sound in the loop.

It is important that no slice plays two consecutive sounds, so audition them
one at a time to check.

Set the Time Signature and length (Bars/Beats) to whatever the
length of the loop.
The Tempo is calculated.

Click the Preview Toggle button to enter Preview mode.

The Stretch factor is by default set to 40%.

Use the Preview Tempo knob to check how the loop plays back at different
tempi and change the Stretch setting according to how much you want to
lower the tempo.

From here you have three ways to go, depending on what you would like to do
with the loop:

Y

Y

You could select your sampler from the Sampler menu and choose
“MIDI File +Transmit”.

You could export the file in another format using the Export dialog.

See next page.

You could save the file as a REX2 file.
See page 76.

In case of it being a Transmit to sampler operation (and some of the Export for-
mats), you proceed as follows:

7.

8.

Set things up so that the sequencer plays the new program file in
your sampler.

Load the MIDI File into your sequencer and play it back.
Try varying the tempo.

Slicing for Tempo
Changes - Exporting to
Audio File

In the previous example, the result was a number of slices - in a sampler keymap
or contained in a REX2 file. However, if you plan to use the file in an application
that only reads regular Wave and AIFF files, you want to export your loop as one
file, in any specific tempo or pitch that you decide. Proceed as follows:

1.
2,

Follow steps 1 to 6 in the previous example.

Enter the tempo, and/or the pitch that you wish the file to play back
in (you can also add additional processing if you like).

If you have lowered the tempo by a large amount, check (listen for “gaps”
between the slices) if you have to raise the stretch amount.

Activate “Transmit as One Sample” on the Process menu.

Export the file in the format of your choice using the Export File di-
alog - see page 76.

The result is a single file that plays in the tempo and pitch specified by the
Preview settings.
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Slicing for Editing

If your main goal is to edit the loop, rather than changing its tempo, you may take
a slightly different approach compared with slicing for tempo changes:

1. Set things up as in the previous example.
If you activate “Show Grid” on the View menu, finding exact positions be-
comes much easier.

2. Work on the slices with the Hide and Lock tools until you have ap-
proximately one slice per eighth note, sixteenth note or whatever
you need, depending on how detailed an edit you want to do.

If a slice plays more than one sound, please remember that you won't be
able to edit these two sounds independently. There are occasions when this
will be perfectly OK though, for example when you just want to shift the or-
der of the beats around in the loop.

3. Proceed as from point 5 in the previous example.

4. In the MIDI Sequencer, open the MIDI File for editing.
When you move slices around, make sure they keep their relative position to
the beats, eighth notes etc., to maintain the integrity of the timing in the
groove.

Using Silence Selected

Even if you don’t want to cut up a loop in slices, you can still use ReCycle to
send different sounds in the loop to different outputs on your sampler to apply
processing to only one drum in a loop for example. The example below assumes
you only want to pick out one sound, but the same technique can of course be
applied to separate as many sounds as you need.

1. Open or Receive the sample.
2. Raise the Sensitivity until a lot of slices appear.

3. Activate playback and move the loop points until you find a good
loop.

4. Set the Time Signature and length (Bars/Beats) to whatever the
length of the loop.
The Tempo gets calculated.

5. Click the Preview toggle button to enter Preview mode.

Make sure “Silence Selected” and “Transmit as One Sample” are
activated (ticked) on the Process menu.

7. Work on the slices until they play one sound each when you click on
them.

8. Select all slice markers which play the same sound, for example the
snare drum.
Play it back to check that all snares are silent.

9. Select your actual Sampler from the sampler menu and select
Transmit or MIDI File+Transmit, or simplyexport the file in the for-
mat of your choice using the Export dialog or save the file.

The MIDI File you get will contain one event which plays the entire loop at
the calculated tempo.

10. With the selection still set up as before, select “Invert Selection”
from the Edit menu.
Now all sounds that are not snares are selected.

1

-

. Transmit the sample again to the sampler, but under another name.

12. Set up the sampler and sequencer so that the two samples are
played back at the same time. Also set up the sounds to one output
each.

They will together recreate the loop as it was, but the snare will be separated
to its own output, which means that you have independent control over its
volume, that you can process it separately etc.
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Extracting a Groove

If you think about it, you will realize that all ReCycle MIDI Files are actually timing
maps of how the drums were played in the loop. Many sequencer programs
have the ability to load MIDI Files and apply their timing to the sequenced parts.
The terminology used is “Match Quantize” or “Groove”.

If you use a ReCycle MIDI File as a “groove template”, you can make your se-
quenced parts play back with the timing of the drum loop. For this, you could of
course use the MIDI File you get when Transmitting slices to the sampler. But,
you can also create a timing file only, by exporting the file as a Standard MIDI
File. Proceed as follows:

1. Open or Receive the sample.
2. Raise the Sensitivity Slider until a lot of slices appear.

3. Activate “Show Grid” on the View menu and work on the slices with
the Hide and Lock tools until you have one slice per eighth note or
sixteenth note.

In many situations there will be no sound on a certain eighth or sixteenth
note. There's not much you can do about this. You can copy another MIDI
note in the sequencer later, or insert a new one “by hand”. You can also add
a slice manually, at any position.

4. Set the Time Signature and length (Bars/Beats) to whatever the
length of the loop.
The Tempo gets calculated.

5. Make sure “Silence Selected” and “Transmit as One Sample” are
not activated on the Process menu.
These items should not be ticked.

6. Select Export from the File menu and save as a Standard MIDI File.

< If you use Propellerhead’s Reason, applying a groove to existing
music is a piece of cake. Just Import the MIDI File (or open a REX2
file - you can simply use the “To Track” function to create MIDI data
from the REX2 file) in Reason and select “Get User Groove” from
the Edit menu.

Quantizing Audio

If you have sliced a groove or other recording, you can apply quantizing to it in
the sequencer, if you like.

! When Transmitting, always use at least a small amount of Stretch,
to avoid the gaps between slices that might otherwise occur.

Please note that if you have two REX2 loops in Reason, applying the timing of
one of them to the other is really easy. Use the “To Track” function in Dr. Rex for
one of the loops, and select the resultant MIDI notes in the sequencer. Now se-
lect “Get User Groove” on the Edit menu. Now you can quantize the other loop’s
MIDI note data using the User Groove (see the Reason manual for details).

If you don't like what you get, Undo the Quantize, and try the other way around,
for example.
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Extracting Sounds

This can be used to extract single sounds (snares, hi-hats etc.) from a loop or
other recording. It can also be very useful if you have recorded more than one
drum loop into a file and want to save each one as a separate file.

1. Open or Receive the sample.

2. Raise the Sensitivity Slider until the desired number of slices ap-
pears.

3. Set “Bars” to any value but zero.
Click the Preview Toggle button to enter Preview mode.

5. Work on the slices with the Hide and Lock tools until you get the
sounds you want when you audition.
In the case of the “multi-loop” file outlined above, this would mean one slice
per loop.

6. Setthe Loop point to enclose the first and last sound you want from
the audio file.
This might mean unwanted sounds are transmitted, but these can always be
deleted in the sampler. Or you can use “Silence Selected” to prevent some
slices from being sent.

< Also in the case of the multiple loop or Silence Selected scenario,
you could use the Gate Sensitivity parameter to prevent silent pas-
sages from being transmitted.
See page 67.

7. Select your Sampler from the Sampler menu and select Transmit.
The slices get transmitted. Alternatively, you can use Export Sound to save
each slice as a file in a format of your choice.

Using Loops with unusual
length or cutting

Sometimes you don't have a full bar of a loop. Set up the loop and the Bars and
Beats fields for as much as you have. Then slice the loop. Finally, use your se-
quencer’s editing capabilities, on the MIDI notes, to recreate the missing parts.

You will also encounter situations where the best loop doesn't really start on a
downbeat. It might for example happen that you get the best loop when you po-
sition the Left and Right Locator on the last quarter note of two consecutive
measures.

If this happens, you can fix it in your sequencer, by cutting the last quarter note
of the MIDI Part and pasting it in at the beginning, to position the downbeat cor-
rectly. If you don't want to slice the loop completely, at least allow a slice at the
downbeat (the Lock tool is ideal for this). Then, repositioning that last quarter
note to the beginning of the loop will be very easy.
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